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Important User Information
Solid state equipment has operational characteristics differing from those of electromechanical equipment. Safety
Guidelines for the Application, Installation and Maintenance of Solid State Controls (publication SGI-1.1 available from
your local Rockwell Automation sales office or online at http://literature.rockwellautomation.com) describes some im-
portant differences between solid state equipment and hard-wired electromechanical devices. Because of this differ-
ence, and also because of the wide variety of uses for solid state equipment, all persons responsible for applying this
equipment must satisfy themselves that each intended application of this equipment is acceptable.

In no event will Rockwell Automation, Inc. be responsible or liable for indirect or consequential damages resulting
from the use or application of this equipment.

The examples and diagrams in this manual are included solely for illustrative purposes. Because of the many variables
and requirements associated with any particular installation, Rockwell Automation, Inc. cannot assume responsibility
or liability for actual use based on the examples and diagrams.

No patent liability is assumed by Rockwell Automation, Inc. with respect to use of information, circuits, equipment,
or software described in this manual.

Reproduction of the contents of this manual, in whole or in part, without written permission of Rockwell Automation,
Inc., is prohibited.

Throughout this manual, when necessary, we use notes to make you aware of safety considerations.

Allen-Bradley, ControlLogix, DataSite, FactoryTalk, FactoryTalk View ME, FactoryTalk View SE, PanelView, PanelView Plus, RSLogix 5000, RSLinx, Rockwell Automation, and TechConnect are 
trademarks of Rockwell Automation, Inc.

Trademarks not belonging to Rockwell Automation are property of their respective companies.

WARNING
Identifies information about practices or circumstances that can cause an explosion in a 
hazardous environment, which may lead to personal injury or death, property damage, or 
economic loss.

IMPORTANT Identifies information that is critical for successful application and understanding of the product.

ATTENTION Identifies information about practices or circumstances that can lead to personal injury or death, 
property damage, or economic loss. Attentions help you identify a hazard, avoid a hazard, and 
recognize the consequence

SHOCK HAZARD Labels may be on or inside the equipment, for example, a drive or motor, to alert people that 
dangerous voltage may be present.

BURN HAZARD Labels may be on or inside the equipment, for example, a drive or motor, to alert people that 
surfaces may reach dangerous temperatures.

http://literature.rockwellautomation.com
http://literature.rockwellautomation.com/idc/groups/literature/documents/in/sgi-in001_-en-p.pdf


Where to Start

Follow this path to complete your DataSite application.

Chapter 1
Hardware Selection

Chapter 2
System Layout and Wiring

Chapter 3
DataSite and Logix Integration

Chapter 5
FactoryTalk View Integration

Chapter 6
System Validation

Chapter 4
DataSite Workbench and Screen Builder Integration
3Publication IASIMP-QS008A-EN-P - March 2009 3



Where to Start
DataSite Configurations

This quick start shows how to set up and configure three functional DataSite configurations.

• DataSite to ControlLogix master (Chapter 1 through 6)

• DataSite to FactoryTalk View ME master (Appendix A)

• DataSite to FactoryTalk View SE master with data logging capabilities (Appendix B)

Chapter 1 through 6 cover the DataSite to ControlLogix Master configuration. In this configuration, a 
DataSite unit communicates via RF radio modems to a ControlLogix L63 controller and displays the natural 
gas flow data on a PanelView Plus 1000 terminal. 
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Where to Start
The DataSite to FactoryTalk View ME Master configuration is good for small applications that don’t require 
a ControlLogix controller to poll multiple DataSite units. The PanelView Plus 600 terminal communicates 
with the DataSite unit using Modbus serial communication.

DataSite to FactoryTalk View ME Master

The Factory Talk View SE Master configuration is good for small applications that don’t require a 
ControlLogix controller but do require data logging capabilities. The industrial computer running 
FactoryTalk View SE communicates with the DataSite using Modbus TCP/IP Ethernet communication.

DataSite to FactoryTalk View SE Master

2711-NC13 Serial Cable

2711P PanelView Plus 600 Terminal 

1758-FLO302 Datasite
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Where to Start
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Preface

About This Publication This quick start provides step-by-step instructions on how to set up 
and configure three functional DataSite configurations. 

• DataSite to a ControlLogix master (Chapter 1 through 6)

• DataSite to a FactoryTalk View Machine Edition (ME) master 
(Appendix A)

• DataSite to a FactoryTalk View Site Edition (SE) master with data 
logging capabilities (Appendix B)

The examples are designed to get devices installed and 
communicating with each other in the simplest way possible. The 
programming is not complex and offers easy solutions to verify that 
devices are communicating properly

To assist in the design and installation of your DataSite configuration, 
application files and other information is provided on the DataSite 
Accelerator Toolkit CD, publication IASIMP-SP011. This CD provides 
CAD drawings for panel layout and wiring, base Logix control 
programs, FactoryTalk View HMI application files, and more. For a 
copy of the CD, contact your local Rockwell Automation distributor or 
sales representative. With these tools and the built-in best-practices 
design, you can focus on the design of your system and not on design 
overhead tasks. 

The beginning of each chapter contains the following information. 
Read these sections carefully before beginning work in each chapter.

• Before You Begin - This section lists the steps that must be 
completed and decisions that must be made before starting that 
chapter. The chapters in this quick start do not have to be 
completed in the order in which they appear, but this section 
defines the minimum amount of preparation required before 
completing the current chapter.

• What You Need - This section lists the tools that are required to 
complete the steps in the current chapter. This includes, but is 
not limited to, hardware and software.

• Follow These Steps - This illustrates the steps in the current 
chapter and identifies which steps are required to complete the 
examples using specific networks.

IMPORTANT Before using this quick start and the contents of the DataSite 
Accelerator CD, read the Terms and Conditions on the CD.
9Publication IASIMP-QS008A-EN-P - March 2009 9



Preface        
Software Requirements You need the following software to use this toolkit.

Conventions This quick start uses the following conventions.

Rockwell Automation Software Version

DataSite Workbench 5.2

DataSite Screen Builder 1.3

DS FloConfig 1.0

RSLogix 5000 16

FactoryTalk View Studio, including:

• Machine Edition (ME)

• Site Edition (SE)

5.0

Proposal Works 6.1

Java Runtime Environment 6, Update 7

DataSite Accelerator Toolkit CD Not applicable

Convention Meaning Example

Click Click the left mouse button once. (Assumes cursor is positioned 
on object or selection.) Click Browse.

Double-click Click the left mouse button twice in quick succession while the 
cursor is positioned on object or selection. Double-click the application icon. 

Right-click Click the right mouse button once while the cursor is positioned 
on object or selection. Right-click the Fieldbus Networks icon. 

Drag and drop
Click and hold the left mouse button on an object, move the 
cursor to where you want to move the object, and release the 
mouse button.

Drag and drop the desired block into the Strategy 
window.

Select Click to highlight a menu item or list choice. Select New Module from the pull-down list.

Check or uncheck Click to activate or deactivate a checkbox. Check the Disable Keying checkbox.

> Shows nested menu selections as menu name followed by menu 
selection. Select File>New.

Expand Click the + to the left of a given item /folder to show its 
contents. Expand the Main Task. 
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        Preface
Additional Resources

You can view or download publications at 
http://literature.rockwellautomation.com. To order paper copies of 
technical documentation, contact your local Rockwell Automation 
distributor or sales representative.

Resource Description

DataSite Natural Gas Flow Meter and Remote Terminal 
Unit Installation Instructions, publication 1758-IN001

Describes how to install and wire the Datasite unit.

DataSite Electronic Flow Meter and Remote Terminal 
User Manual, publication 1758-UM001

Describes how to design, install, program, or troubleshoot control systems that 
use DataSite controllers.

Customized Function Blocks for DataSite Reference 
Manual, publication 1758-RM001

Describes the customized function blocks that are used to program DataSite 
units using DataSite Workbench software.

DataSite Electronic Flow Meter and Remote Terminal, 
Software User Manual, publication 1758-UM002

Describes the software tools that are used to configure and monitor the 
DataSite controller, such as DS settings, DS FloConfig, and DS NP3.

http://www.ab.com/programmablecontrol/plc/datasite Provides information related to the DataSite unit.   

Rockwell Automation Configuration and Selection Tools, 
available at 
http://www.rockwellautomation.com/en/e-tools/

These online tools install on your personal computer so that you can quickly 
access information on our products.

• Proposal Works

• Industrial Computer Selector

• Operator Interface Selection Tool

• Programmable Controller Family Selector

http://www.rockwellautomation.com/solutions/integrat
edarchitecture/

Provides information on integrated architecture tools and resources including 
accelerator toolkits. 

http://www.prosoft-technology.com/ Provides information regarding ProSoft Technology products and technical 
support. The Modbus TCP/IP Communication Module (MVI56-MNET) used in 
this quick start is a product of ProSoft Technology.

Contact technical support by emailing support@prosoft-technology.com or 
calling 1 +  (661) 716-5100.
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Chapter 1

Hardware Selection

Introduction

In this chapter, you select the hardware for your application. You can select any of the three 
DataSite configurations covered in this quick start. Within each configuration, you have the 
option to purchase a pre-assembled DataSite panel or one that requires assembly. This chapter 
provides step-by-step instructions on how to use the Bill of Materials (BOM) provided with the 
DataSite Accelerator Toolkit CD. 

Before You Begin

Verify that your computer meets the software requirements of Proposal Works software.

What You Need

• DataSite Accelerator Toolkit CD, publication IASIMP-SP011
For a copy of the CD, contact your local Rockwell Automation distributor or sales 
representative.

• Personal computer with Internet access for downloading software.
13Publication IASIMP-QS008A-EN-P - March 2009 13



Chapter 1       Hardware Selection
Review Basic Panel Component Listings

The bill of materials (BOM) on the DataSite Accelerator Toolkit CD includes the necessary 
components to duplicate the three DataSite configurations covered in this quick start. Review the 
component listings and compare with your specific application needs.

Follow these steps to view the BOM on the DataSite Accelerator Toolkit CD for the DataSite to 
ControlLogix Master configuration.

1. Launch the DataSite Accelerator Toolkit CD.

2. Select DataSite Development Tools.

3. Choose DataSite to ControlLogix 
Master>Bill of Material, then double-click 
DataSite_to_CLX.prp.
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Hardware Selection        Chapter 1
Proposal Works 
launches and 
displays the BOM 
for the DataSite to 
ControlLogix Master 
configuration.

4. Review the BOM 
and modify to fit 
your application.

5. After finalizing the BOM, 
click the Word icon on 
the toolbar to convert the 
BOM to a Word 
document.

Word launches and 
displays the BOM.

6. Repeat steps 2 - 5 to view the BOMs for the other two DataSite configurations.

• DataSite Development Tools>DataSite to FactoryTalk View ME Master>Bill of 
Material>DataSite_to ME_.prp.

• DataSite Development Tools>DataSite to FactoryTalk View SE Master>Bill of 
Material>DataSite_to_SE.prp.

TIP Double-click a bolded part number to launch the configurator 
where you can modify components on the bill of material
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Chapter 1       Hardware Selection
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Chapter 2

System Layout and Wiring

Introduction

In this chapter, you plan the panel layout and wiring for your DataSite system. You can use the 
AutoCAD electrical drawings supplied on the DataSite Accelerator Toolkit CD to add or remove 
components in your DataSite system. 

Before You Begin

Complete your system hardware selection (Chapter 1).

What You Need

• DataSite Accelerator Toolkit CD, publication IASIMP-SP011
For a copy of the CD, contact your local Rockwell Automation distributor or sales 
representative.

• AutoCAD electrical software to open DWG or DXF files.

• Adobe Acrobat Reader software to open PDF files.
• System Design for Control of Electrical Reference Manual, publication GMC-RM001.
• Documentation for your other Allen-Bradley products.

Go to Literature Library at http://literature.rockwellautomation.com for access to Rockwell 
Automation publications.

TIP Use AutoCAD electrical software to take advantage of advanced features of the project 
provided.
17Publication IASIMP-QS008A-EN-P - March 2009 17
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Chapter 2       System Layout and Wiring
Follow These Steps

Review DataSite Connections

page 20

page 24

page 19

Plan Your DataSite Panel Layout 
and Wiring

Download Other Allen-Bradley 
CAD Drawings

Verifying Your Basic Panel 
Layout

page 18

Review DataSite Connections

Item Description Item Description

1 Discrete inputs and wake-up connectors 6 RS-485 COM 1 connector

2 Status indicators 7 Discrete output connectors

3 Ethernet connector 8 Power input and analog input connectors

4 RS-232 COM 2 connector 9 HART, pulse input, and analog output connectors

5 RS-232 COM 1 connector 10 Pulse input filter switches
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System Layout and Wiring        Chapter 2
Plan Your DataSite Panel Layout and Wiring

The DataSite Accelerator Toolkit CD includes AutoCAD Electrical project files that include panel 
layout and wiring diagrams that you can easily modify for your specific application. Individual 
DWG, DXF, and PDF files are available for use in standard AutoCAD and non-AutoCAD drawing 
and image software packages. The drawings are designed to optimize panel space and minimize 
electrical noise.

Follow these steps to load CAD files from the DataSite Accelerator Toolkit CD.

1. On the toolkit CD, select DataSite Development Tools.

2. Choose DataSite to ControlLogix Master>AutoCAD Electrical CAD.

3. Open the DWG or DXF folder.

4. Use your CAD program to open the DWG or DXF files.

5. Identify additional layout needs specific to your application. 

6. Repeat steps 2 - 5 to view the CAD files for the other two DataSite configurations.

• DataSite to FactoryTalk View ME Master>AutoCAD Electrical CAD

• DataSite to FactoryTalk View SE Master>AutoCAD Electrical CAD

TIP The PDF file contains the same information as the individual DXF and DWG files. Use 
Adobe Acrobat Reader to open the PDF file.
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Chapter 2       System Layout and Wiring
Verifying Your Basic Panel Layout

The AutoCAD Electrical project includes panel layouts and wiring diagrams for each of the three  
DataSite configurations. Add or remove components as needed. 

Panel Layouts for the DataSite to ControlLogix Master Configuration

The DataSite to ControlLogix Master configuration includes panel layouts for host and remote 
locations. Refer to the bill of material below each layout to review the items in each panel.   

Host DataSite Location - Panel Layout

Sample Bill of Material - Host DataSite Panel Layout
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System Layout and Wiring        Chapter 2
Remote DataSite Location - Panel Layout

Sample Bill of Material - Remote DataSite Location
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Chapter 2       System Layout and Wiring
Wiring Diagrams for the DataSite to ControlLogix Master Configuration 

The AutoCAD electrical project includes wiring diagrams for each of the three DataSite 
configurations. The example shows power wiring for the DataSite to ControlLogix Master 
configuration. Add or remove components as needed.

Sample CAD Wiring Diagram
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System Layout and Wiring        Chapter 2
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Chapter 2       System Layout and Wiring
Download Other Allen-Bradley CAD Drawings

Follow these steps to download other Allen-Bradley product CAD drawings. 

1. Open your browser and go to http://ab.com/e-tools.

The Configuration and Selection tools web page opens.

2. If you don’t know the complete catalog 
number, click product directory to 
browse the configured Rockwell 
Automation products.

3. Click Rockwell Automation and follow 
the prompts.

TIP If you know the complete catalog number of your Allen-Bradley product, you can enter it here and click 
Submit. However, you need a complete catalog number string to get the configuration results.
24 Publication IASIMP-QS008A-EN-P - March 2009
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Chapter 3

DataSite and Logix Integration

Introduction

In this chapter, you configure the DataSite unit, download the ControlLogix user program, 
configure the ProSoft (MVI56-MNET) Modbus TCP/IP communication module, and connect all 
system devices.

Before You Begin

• Complete your system hardware selection (Chapter 1).
• Complete your system layout and wiring (Chapter 2).
• Load all DataSite software on your computer as listed in the Preface on page 10. In this 

chapter, you will use the DS FloConfig and RSLogix 5000 software.
• Assign IP addresses to all devices on network. The table lists IP addresses used in this 

quick start. 

This chapter assigns IP addresses to the 1756-ENBT Ethernet module, the DataSite unit, and 
the Prosoft MV156-MNET module. For details on how to assign an IP address to the 
PanelView Plus terminal, refer to the PanelView Plus Terminals User Manual, publication 
2711P-UM001. For the other devices, refer to the manufacturer’s user manual. 

What You Need

• Personal computer or laptop
• Hardware:

– 1758-FLOxxx DataSite Unit 
– 1756-L63 ControlLogix controller
– 1756-ENBT EtherNet/IP module

Device IP Address Device IP Address

1756-ENBT Ethernet module 192.168.10.90 ProSoft MV156-MNET module 192.168.10.94

Master radio 192.168.10.91 Personal computer 192.168.10.95

Remote radio 192.168.10.92 PanelView Plus 1000 terminal 192.168.10.96

DataSite unit 192.168.10.93
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Chapter 3       DataSite and Logix Integration
– Modbus TCP/IP communication module (MV156-MNET) from ProSoft Technology
– PanelView Plus 1000 terminal
– Two Ethernet RF radios
– 1747-CP3 null-modem serial cable
– One Ethernet crossover cable
– Five Ethernet straight-through cables
– Ethernet switch

• Software:
– DS FloConfig software
– RSLogix 1000 software
– DataSite Accelerator Toolkit CD, publication IASIMP-SP011

Follow These Steps

page 42

Configure the DataSite Unit

Configure the ControlLogix 
Controller Properties

page 27

page 32

page 31

Load and Open the Logix 
Application File

Configuring the Logix Controller

Save and Download Your 
Program

page 34

page 33

Configure ControlLogix 
Communication

Configure the ProSoft Modbus 
Module

page 36

Connecting All Devices
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Configure the DataSite Unit

The communication parameters for the DataSite unit are configured using DS FloConfig software. 
The DataSite unit can communicate using either its serial or Ethernet port. This quick start uses 
the serial port to assign the DataSite unit an IP address of 192.168.10.93 and then changes to 
Ethernet communication. 

Follow these steps to assign an IP address, 192.168.10.93, and configure Ethernet communication 
for the DataSite unit.

1. Connect a 1747-CP3 
(null-modem) serial cable 
between your computer's 
serial port and the COM2 
port on the DataSite unit.

2. Apply 12V DC power to 
the DataSite unit.

3. Launch the DS FloConfig 
software.

The path shown may be 
different on your 
computer depending on 
where the software is 
installed.

4. Select New Project and 
click OK.

TIP Make sure your computer or laptop is assigned an IP address where the first three octets are the same as 
the DataSite unit, 192.168.10.XX. In this quick start, the computer uses a static IP address of 
192.168.10.95 with a subnet mask of 255.255.255.0.

1747-CP3 Null-modem Serial Cable

COM2 Serial Port Serial Port

192.168.10.93 192.168.10.95
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5. Create a new project.

a. Enter a project name.

b. Enter the directory 
where you want to 
store the project.

This examples saves the 
project in the default 
directory.

c. Click Create.

6. Click PC Communication.

a. Select COM1 from the 
Type Select pull-down 
list.

b. Click Apply.

A message informs you 
that the Communication 
port opened successfully.

c. Click OK.
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7. Click Flo Communication, 
then click Upload.
The screen refreshes with 
the existing IP address 
and serial port settings. 

8. Click OK when you see 
Upload Successful.

9. Under Ethernet: 

a. Type the IP address for 
the DataSite unit.
This example uses 
192.168.10.93.

b. Click Download.

c. Click OK when you see 
the Download 
successful message.

10. Cycle power to the 
DataSite unit.
You must power cycle 
when changing the IP 
address. 
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11. Click PC Communication.

a. Select UDP or 
TCP/Server from the 
Type Select pull-down 
list.

b. Type the IP address, 
192.168.10.93 that you 
just downloaded to the 
DataSite unit.

c. Click Apply.

d. Click OK when you see 
Communication port 
opened successfully.

12. Connect your computer 
to the DataSite unit using 
an Ethernet crossover 
cable.

13. Click Flo Communication.

a. Verify the IP address is 
192.168.10.93.

b. Click Download.

c. Click OK when you see 
the Download 
successful message.

The IP address of the DataSite unit was set successfully and now uses Ethernet communication.

Ethernet Crossover Cable
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Configuring the Logix Controller

The sample Logix program on the DataSite Accelerator Toolkit CD provides the logic necessary to 
manipulate data coming from the Modbus TCP/IP communication module and makes it available 
to the ControlLogix L63 controller tags.

Load and Open the Logix Application File

Follow these steps to load and open the (.acd) Logix application file from the DataSite 
Accelerator Toolkit CD.

1. On the toolkit CD, choose DataSite to ControlLogix Master>Controller Program Files, then 
double-click the DataSite_RTU.ACD application file.

The RSLogix 5000 
software 
launches and 
opens the.acd 
file.
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Configure the ControlLogix Controller Properties

Follow these steps to configure your ControlLogix L63 controller.

1. Apply power to your 
ControlLogix chassis.

2. Connect your computer 
and 1756-ENBT Ethernet 
module to the Ethernet 
switch using Ethernet 
straight-through cables.

3. Choose Controller 
Properties from the Edit 
menu to open the 
Controller Properties 
dialog box.

4. Click the General tab.

a. Click the Change 
Controller button to 
select the controller 
that matches your 
hardware.
This example uses 
1756-L63 revision 16.

b. Change the controller 
Name as desired.

c. From the Chassis Type 
pull-down list, select 
the catalog number for 
your chassis.

d. Set the slot number to 
0 to indicate the 
1756-L63 controller 
resides in slot 0.

e. Click OK.

Ethernet Straight-through Cables

192.168.10.951756-L63 ControlLogix Controller 
with 1756-ENBT Ethernet/IP Module

EN
BT

Pr
oS

of
t

Ethernet Switch

ENBT Module
192.168.10.90

TIP Slot 0 is reserved for the 1756-L63 module. Slot 1 is reserved 
for the 1756-ENBT module. Slot 2 is reserved for the ProSoft 
Modbus TCP/IP module.
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Configure ControlLogix Communication

This procedure assumes that communication to the Logix controller is using the Ethernet port. It 
also assumes that your 1756-ENBT Ethernet/IP module has already been configured with an IP 
address of 192.168.10.90. 

For additional information, refer to the ControlLogix Controllers User Manual, publication 
1756-UM051.

Follow these steps to configure ControlLogix communication.

1. Open the RSLinx Classic software, then choose Configure Drivers... from the 
Communications menu.

The Configure Drivers 
Window opens.

2. Select Ethernet devices 
from the pull-down list.

3. Click the Add New 
button.

4. Accept the default driver 
name, AB_ETH-1, or 
change the name and 
click OK.
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5. Enter the IP address of 
your Ethernet ENBT 
module and click OK.

This example uses 
192.168.10.90.

6. Click Close to close the Configure Drivers window.

7. Choose RSWho from the 
Communications menu.

The RSWho window 
opens.

8. Expand AB_ETH_1, 
Ethernet until your 
1756-L63 Logix controller 
is visible.

9. Verify that you can 
browse to your Logix 
controller in slot 0.

10. Minimize the RSLinx window and return to your RSLogix 5000 project window.

Save and Download Your Program

Follow these steps to save your program and download it to the ControlLogix controller.

1. Click Verify Controller on the RSLogix 
5000 toolbar to verify the Logix program. 

If any errors or warnings occur, they display at the bottom of the window.

2. Choose Save from the File menu to save the program.

3. Click Who Active.
34 Publication IASIMP-QS008A-EN-P - March 2009



DataSite and Logix Integration        Chapter 3
4. Browse to the 1756-L63 
controller and click the 
Set Project Path button.

5. Verify that the key switch 
on the controller is in the 
REM (remote) position.

6. Click Download.

The Download window 
opens.

7. Click Download to send 
the program to the 
1756-L63 controller.

8. Click No when the 
download is complete.
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Configure the ProSoft Modbus Module

The ProSoft MV156-MNET Modbus TCP/IP communication module polls the Modbus registers of 
the DataSite unit and makes the data available to the 1756-L63 controller tags. The Prosoft module 
slides into slot 2 of the ControlLogix chassis and requires two configuration (.cfg) files to operate.  

• WATTCP.CFG assigns an IP address to the ProSoft MVI56-MNET module.
• MNET.CFG defines the list of Modbus registers to read from or write to the DataSite unit. 

You will download these configuration files from the DataSite Accelerator Toolkit CD. 

The WATTCP.CFG file was modified to assign the ProSoft MVI56-MNET module an IP Address of 
192.168.10.94. The MNET.CFG file was modified to poll 19 DataSite natural gas Modbus registers 
from each of the 8 meter runs which will display on a PanelView Plus 1000 terminal. 

If necessary, you can use Notepad to open and modify the configuration files. For more 
information on these files and how they were created, refer to the MVI56-MNET User Manual in 
the DSAT Common Tools>Literature and Support Info>ProSoft directory of the Accelerator Toolkit 
CD. In addition to the configuration files, a (.acd) Logix program is required to manipulate the 
Modbus data written to the L63 controller tags. Refer to page 31 for details on how to download 
the Logix program.

IMPORTANT All system devices must be configured and connected before 
placing the controller in Run mode. If the controller is already in 
Run mode, choose Offline from the Communications menu.

IMPORTANT The.acd Logix program was downloaded on page 31 in the Configuring the Logix Controller 
section. You must download the Logix program to the ControlLogix L63 controller before you 
configure the Prosoft Modbus module. 

TIP For technical support on the Prosoft MVI56-MNET module, email support@prosoft-technology.com or call 
the technical support number 1 + (661) 716-5100 that is available at http://www.prosoft-technology.com/
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Follow these steps to download the WATTCP.CFG and MNET.CFG configuration files from the 
DataSite Accelerator Toolkit CD to the ProSoft Modbus module.

1. On the toolkit CD, choose DataSite to ControlLogix Master>ProSoft Interface Module Files, 
then copy the files MNET.CFG and WATTCP.CFG to your desktop.

2. Install the ProSoft 
Modbus module into slot 
2 of the Logic chassis.
Slot 2 is used in this quick 
start. If you change the 
slot number, then you 
must modify the .acd 
Logix program.

3. Apply power to the 
chassis.

4. Connect the serial cable 
that ships with the ProSoft 
module between the 
serial port on your 
computer and the (RJ45) 
CFG port on the ProSoft 
module.

To CFG
(RJ45) Port

Slot 2

Cable Shipped with ProSoft Module

192.168.10.95ProSoft Module, Slot 2
192.168.90.94

EN
BT

Pr
oS

of
t

To Serial COM Port

TIP Disconnect the serial cable that you previously used to connect 
your computer to the DataSite unit.
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5. Choose Start>Programs>Accessories>Communications>HyperTerminal to open the hyper 
terminal on your desktop.

6. Click No if you see this 
dialog box.

7. Enter a name for the new 
connection and click OK.

8. Select the COM port used 
by your computer and 
click OK.
This example uses COM1.
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9. Set the COM1 port 
settings as shown and 
click OK.

10. Press Shift+? to display 
the MVI56-MNET menu.

11. Press R, then press Y to 
transfer the MNET.CFG 
file.

12. From the Transfer menu, 
choose Send File.

TIP After pressing Y, you have limited time to browse for 
the file before a timeout occurs.
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13. From the Send File dialog 
box:

a. Click Browse to locate 
MNET.CFG, then click 
Open.

b. Select Zmodem from 
the Protocol list.

c. Press Send.

A progress bar shows the 
status of the file transfer.

14. Press Shift+? to return to 
the main menu.

15. Press Shift+@, then 
Shift+? to display the 
Network menu.

16. Press R, then Y to transfer 
WATTCP.CFG. 

17. From the Transfer menu, 
choose Send File.

TIP After pressing Y, you have limited time to browse for the file 
before a timeout occurs.
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18. From the Send File dialog 
box:

a. Click Browse to locate 
WATTCP.CFG, then 
click Open.

b. Select Zmodem from 
the Protocol list.

c. Press Send.

A progress bar shows the 
status of the transfer.

19. Press Shift+? to display 
the Network menu; then 
press M followed by 
Shift+? to return the main 
menu.

The ProSoft Modbus 
module is now 
configured.

20. Close the HyperTerminal 
dialog box.

21. Cycle power to the 
ProSoft module by 
pulling it from the chassis 
and re-inserting it.

This registers the new IP 
address.
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Connecting All Devices

At this point all devices should be connected as shown in the illustration. Modify any previous 
connections, if necessary, to match the illustration.

You must use an Ethernet crossover cable to connect the DataSite unit to the radio. The cable 
between the Ethernet switch and the ProSoft MVI56-MNET Modbus module must connect to the 
RJ45 Ethernet Port; not the CFG port. 

The configuration of the Ethernet radio modems is not covered in this quick start. Refer to your 
radio user manual for instructions on how to configure and assign IP addresses to both radios.  
After wiring is complete, apply power to all devices.

TIP Radios are optional. If your application does not require radios simply replace the radios 
with an Ethernet straight-through cable connecting the DataSite to the Ethernet switch.

2711P PanelView Plus 1000 Terminal 
with Built-in Ethernet Port

Laptop

Ethernet Switch

Radio

Et
he

rn
et

1756-L63 ControlLogix Controller 
with 1756-ENBT Ethernet/IP and ProSoft Module

Pr
oS

of
t

EN
BT

 
L6

3

Chassis

Remote Location Host Location

Radio

All devices connect to Ethernet switch using Ethernet straight-through cables.

27
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P-
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L-
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1758-FLO302 Datasite
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DataSite Workbench and Screen Builder Integration

Introduction

In this chapter, you download the DataSite Workbench sample user program and DataSite Screen 
Builder sample web pages to the DataSite unit.

Before You Begin

• Complete your system hardware selection (Chapter 1).
• Complete your system layout and wiring (Chapter 2).
• Complete the DataSite and Logix Integration (Chapter 3).
• Verify that all devices are connected properly and are powered up.

What You Need

• Personal computer
• All system devices properly connected and powered up
• Hardware: DataSite unit
• Software:

– DataSite Workbench 5.2
– DataSite Screen Builder 1.3
– DataSite Accelerator Toolkit CD, publication IASIMP-SP011
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Follow These Steps

page 45

page 49

Download the DataSite User 
Program

Download the DataSite 
Web Pages
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Download the DataSite User Program

Follow these steps to compile and download the sample DataSite user program. 

1. Launch DataSite Workbench 5.2 software.

2. From the Project/Library 
menu, choose Open.

3. Select the Prj folder from the 
Look in: pull-down list.

4. Double-click the folder 
DataSite_Base_Program.

If you don’t see this dialog 
box, refer to the tip. 

TIP If you don’t see the DataSite_Base_Program folder in step 4, follow these steps. 

• From the DataSite Accelerator Toolkit CD, browse to DSAT Common Tools>DataSite User Programs.

• Copy and paste the DataSite_Base_Program folder to the DataSite Workbench default project directory: 
C:\Documents and Settings\All Users\Documents\DataSite\Projects\Workbench 5.2\prj   or
C:\Documents and Settings\All Users\Shared Documents\DataSite\Projects\Workbench 5.2\prj 

• Now return to step 2 to open the project. 
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5. Double-click PrjLibary.mdb to open the user program.

6. Click the Hardware 
Architecture button.

7. Double-click the Vertical Network Bar, then enter the IP address of the DataSite unit and 
click OK. 
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8. Click the Link Architecture button.

9. Click Rebuild Project/Library.

10. Verify there are no errors.

11. Click the Download button to download the program to the DataSite unit.

12. Click Select All, then click 
Download.
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The DataSite Workbench user program has been downloaded and is running on the DataSite unit.

TIP If the DataSite unit is running a program, you will see a 
message similar to the one below. Click Stop and Download to 
complete the Download process.
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Download the DataSite Web Pages

You will now compile and download the sample DataSite web pages to the DataSite unit. 

Follow these steps to download the HiBeam web pages.

1. Launch the DataSite Screen Builder 1.3 software.

2. From the File menu, choose 
Open.

3. Select the Prj folder from 
the Look in: pull-down list.

4. Double-click the folder 
DataSite_Base_Web_Pages.

If you don’t see this dialog 
box, refer to the tip. 

TIP If you don’t see the DataSite_Base_Web_Pages folder in step 4, follow these steps. 

• From the DataSite Accelerator Toolkit CD, browse to DSAT Common Tools>DataSite Web Pages. 

• Copy and paste the DataSite_Base_Web_Pages folder to the DataSite ScreenBuilder default project directory: 
C:\Documents and Settings\All Users\Documents\DataSite\Projects\ScreenBuilder 1.3\prj  or
C:\Documents and Settings\All Users\Shared Documents\DataSite\Projects\ScreenBuilder 1.3\prj  

• Now return to step 2 to open the project. 
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5. Double-click 
DataSite_Base_Web_Pages.HAD 
to open the web page program.

6. From the toolbar, choose 
Project>Settings.

7. On the Project tab, click 
the Path browse button.

8. Browse to the DataSite 
Workbench default 
project directory. 

9. Double-click the 
DataSite_Base_Program 
folder.

10. Double-click 
PrjLibrary.mdb, then click 
Update connection 
informations from project 
button.

This allows the DataSite 
web pages to access 
variables created in the 
sample DataSite 
Workbench user program.

Default DataSite Workbench project directory:
C:\Documents and Settings\All Users\Documents\DataSite\Projects\Workbench 5.2\Prj  or
C:\Documents and Settings\All Users\Shared Documents\DataSite\Projects\Workbench 5.2\Prj

Step 8

Step 9

Step 10
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11. Click the Data Servers tab.

a. Double-click the row to 
select the IP address of 
the DataSite unit.

b. Click OK.

12. Click the Compile button.

13. Verify there are no errors.

14. Click the Download 
button.

15. Click Options.
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16. Check Send Java Classes 
and click OK.

17. Load the web pages.

a. Select the IP address of 
the DataSite unit.

b. Click the Load button.
Wait two to three 
minutes to complete 
the download process.

c. Click Close when you 
see the message 
Connection OK. 

The DataSite web pages have been successfully downloaded to the DataSite unit. Refer to 
Chapter 6 for system validation and an overview of the DataSite web pages.

TIP Checking the Send JAVA classes box is only required the first 
time you download a project. Subsequent downloads do not 
require you to check this box. 
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FactoryTalk View Integration

Introduction

In this chapter, you download the FactoryTalk View ME project to a PanelView Plus 1000 terminal 
connected to a ControlLogix 1756-L63 controller. 

Before You Begin

• Complete your system hardware selection (Chapter 1).
• Complete your system layout and wiring (Chapter 2).
• Complete the DataSite and Logix Integration (Chapter 3).
• Complete the DataSite Workbench and Screen Builder integration (Chapter 4).
• Verify that all devices are connected properly and are powered up as shown in Connecting 

All Devices on page 42.

What You Need

• Personal computer
• PanelView Plus 1000 terminal with Version 5.0 firmware 
• Software:

– FactoryTalk View ME software
– DataSite Accelerator Toolkit CD
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Follow These Steps

Load and Restore FactoryTalk View ME Application

Follow these steps to load and restore the FactoryTalk View Machine Edition (ME) application 
from the DataSite Accelerator Toolkit CD using the Application Manager.

1. On the toolkit CD, choose DataSite to ControlLogix Master>HMI Application Files, then 
double-click the DataSite_ME_CLX.apa application file.

page 54

Load and Restore FactoryTalk 
View ME Application

page 56

page 59

page 61

page 64

Configure Local 
Communication

Configure Target 
Communication

Download Project to 
PanelView Plus Terminal

Run the Project on PanelView 
Plus Terminal
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The Application Manager 
window opens.

2. Select Restore the 
FactoryTalk View 
Machine Edition 
application and click 
Next.

3. Type DataSite_ME_CLX as 
the application name and 
click Finish.

The Application Manager 
closes after it restores the 
application.
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Configure Local Communication

The Design (Local) tab in Communications Setup reflects the view of the topology from the 
RSLinx Enterprise server on the development computer. In this example, the development 
computer is communicating to a ControlLogix L63 controller via Ethernet communication.

Follow these steps to configure local communication.

1. Apply power to your ControlLogix L63 controller.

2. Verify all cable connections as shown in the wiring diagram on page 42.

3. Launch FactoryTalk View 
Studio software.

If you see this dialog box, 
select Machine Edition 
and click Continue.
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4. Select DataSite_ME_CLX 
from the Existing tab and 
click Open.

The Machine Edition 
application opens.

5. Expand RSLinx Enterprise 
in the Explorer window.

6. Double-click 
Communication Setup.
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The Communication Setup window opens.

7. Select L63 under Device Shortcuts.

8. Click Remove then click Yes to verify the removal of the shortcut.

9. Expand the RSLinx Enterprise tree to access your 1756-L63 controller in slot 0 (0, 1756-L63). 

10. Click Add under Device Shortcuts.

11. Enter L63 as the shortcut name and press Enter.

12. Select your Logix controller 0, 1756-L63.

13. Click Apply under Device Shortcuts.

14. Click Yes to apply changes.
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Configure Target Communication

The Runtime (Target) tab displays the offline configuration from the perspective of the device that 
is running the application and comprises the topology that is loaded in the PanelView Plus 
terminal. In this example, the PanelView Plus terminal communicates to the same 
ControlLogix L63 controller via Ethernet communication.

Follow these steps to configure target communication.

1. Select the Design (Local) tab in the Communication Setup window.

2. Click Copy from Design to Runtime.

A dialog box prompts you to confirm 
the operation.

3. Click Yes.
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4. Select the Runtime (Target) tab and expand the RSLinx Enterprise tree.

5. Click the L63 shortcut to verify that your controller and shortcut name are both highlighted.

In this example, 1756-L63 is the controller in slot 0 and L63 is the shortcut name.

6. Click OK at the bottom right corner of the 
window.
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Download Project to PanelView Plus Terminal

Follow these steps to create a FactoryTalk View ME runtime file and download it to the 
PanelView Plus terminal.

1. Choose Create Runtime 
Application from the 
Application menu.

The Create Runtime 
Application dialog box 
opens.

2. Select Runtime 5.0 
Application (*.mer) from 
the Save as type list.

3. Type 
DataSite_ME_CLX.mer in 
the File name field.

4. Click Save and wait for 
the progress bar to 
complete.

5. Click the File Transfer 
Utility button on the 
toolbar.
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The Transfer Utility opens.

6. Click the Browse ... button to locate the runtime file.

7. Select DataSite_ME_CLX.mer 
from the Runtime folder.

8. Click Open.

Default Runtime folder path:
C:\Documents and Settings\All Users\Documents\RSView Enterprise\ME\Runtime
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9. Browse and select your PanelView Plus terminal, then click Download.

10. Click OK when the 
download completes 
successfully.

11. Click Exit to close the File 
Transfer Utility.

12. Choose Exit from the File 
menu to close the 
FactoryTalk View Studio 
software.

TIP If the PanelView Plus terminal has an existing .mer  file with the same name, click Yes to 
overwrite the file.
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Run the Project on PanelView Plus Terminal

The (.mer) runtime file is now stored in the PanelView Plus terminal so you are ready to run the 
project on the terminal.

Follow these steps to run your project on the PanelView Plus terminal.

1. Verify that the PanelView 
Plus is connected as 
shown on page 42 and 
that it is receiving power.

2. Press Load Application 
[F1] in the FactoryTalk 
View ME Station dialog 
box.

The Load Application 
dialog box opens.

3. Use the up/down arrows 
to scroll through the list 
of applications and select 
DataSite_ME_CLX.mer.

4. Press Load [F2].
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5. Press Yes [F7].

If you press No, the 
communication settings 
from the previously run 
project will be used.

6. Wait for the application to 
the load and verify that 
DataSite_ME_CLX.mer 
appears under Current 
application.

7. Press Run Application 
[F2].

The application builds and displays a DataSite screen on the PanelView Plus terminal.

Refer to Chapter 6 for system validation.
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Chapter 6

System Validation

Introduction

In this chapter, you validate the DataSite system by verifying that all AGA flow data can be seen 
on the PanelView Plus 1000 terminal and on the DataSite web pages.

Before You Begin

• Complete your system hardware selection (Chapter 1).
• Complete your system layout and wiring (Chapter 2).
• Complete the DataSite and Logix Integration (Chapter 3).
• Complete the DataSite Workbench and Screen Builder integration (Chapter 4).
• Complete the FactoryTalk View integration (Chapter 5).
• Verify that all devices are connected properly and are powered up as shown in Connecting 

All Devices on page 42.

What You Need

• Personal computer
• All product hardware from the previous chapters
• Software:

– DS Flo Config
– DataSite Workbench
– RSLogix 5000
– Java Runtime Environment, Version 6 Update 7
– DataSite Accelerator Toolkit CD, publication IASIMP-SP011
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Follow These Steps

Validate DataSite to PanelView 
Plus Communication

Validate DataSite Web 
Pages

page 69

page 75

Review DataSite Workbench 
User Program

page 80
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Validate DataSite to PanelView Plus Communication

You are now ready to validate communication between the DataSite unit and the PanelView Plus 
terminal. Using the DS FloConfig software, you will simulate three process variables and validate 
that the calculated flow values display on the PanelView Plus terminal.

Follow these steps to perform the system validation.

1. Launch the DS 
FloConfig software.

The path shown may 
be different on your 
computer depending 
on where the 
software is installed.

2. Select Open Recent 
Project and click OK.

This DS FloConfig file was created in Chapter 1.

TIP To use actual process variables, wire temperature, pressure, and differential pressure transmitters to the 
DataSite analog inputs.
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3. Select MeterRun0 on the left side of the dialog box.

4. Click Calculation Test and check all three boxes.

a. Type 800 for Static 
Pressure.

b. Type 80 for Temperature.

c. Type 70 for Differential Pressure. 

d. Click OK.

TIP You can optionally repeat steps 3 and 4 for Meter Run1 through Meter Run7.
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5. Click OK when you see the message Download Successful.

6. Expand Meter Run0, select Field Parameters, then click Upload.

7. Check Accumulate and click Download.

8. Return to the RSLogix 
5000 software.

9. Choose Online from 
the Communication 
menu and place your 
L63 ControlLogix 
controller in Run 
mode.

10. Verify the FactoryTalk View ME project is running on the PanelView Plus 1000 terminal. 

If necessary, refer to page 61 for instructions on how to download and run the project.
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11. Press Meter Run 0 on the 
PanelView Plus terminal.

12. Verify the Meter Run 0 
process variables are the 
same as DS FloConfig on 
the next page.
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13. Press Return to Main 
Screen on the PanelView 
Plus terminal.

DS FloConfig Process Variables

TIP You can optionally repeat steps 9 through 12 to validate the process variables for Meter 
Run 1 through Meter Run 7.   
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14. Press DS Digital Outputs 
on the main PanelView 
screen to validate control 
of the DataSite digital 
outputs.

15. Press a digital output.

The push button on the 
left turns ON digital 
output 0.
The push button on the 
right turns ON digital 
output 1.
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The configuration and validation of the Data Site unit to ControlLogix Master is now complete.

Validate DataSite Web Pages

You will now validate the web pages of the DataSite unit using the simulated values from the 
Validate DataSite to PanelView Plus Communication section on page 69. To view the web pages, 
you must have the latest Java runtime environment loaded on your computer. The DataSite 
Accelerator Toolkit CD contains a copy of the required Java runtime environment.

Follow these steps to perform validation of the web pages.

1. From the toolkit CD, choose DSAT 
Common Tools>DataSite Web Pages, 
then double-click the executable, 
jre-6u7-windows-i586-p.exe, to load 
the Java Runtime Environment, 
Version 6 Update 7.

TIP To verify this functionality, you must wire a testing device such 
as a stack light into digital output 0 and another device into 
digital output 1. You must also supply the required voltage to 
terminals DOV+ and DOV-. 

TIP You can skip step 1 if Version 6 Update 7 of the Java Runtime Environment is installed on your computer.
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2. Launch Internet Explorer.

3. In the Address bar, type http://192.168.10.93/datasite.html

Java takes about one 
minute to load this 
screen.

Similar to the PanelView 
Plus terminal, the web 
pages will display the 
same flow data as in 
DS FloConfig.

4. Click Meter Run 0.

IMPORTANT You must enter the correct IP address of the DataSite unit. This 
quick start uses 192.168.10.93
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5. Verify the process variables are the same as in DS FloConfig.

6. Click Main Menu to return to the main application screen.
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7. Click Digital Outputs.

8. Click Digital Output 2.
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9. Repeat the previous step 
to verify Digital Output 3.

You just completed web page validation. Modify the existing sample programs to meet your 
application needs. This example only displays data for one meter run. Duplicate the example, to 
add additional meter runs.

TIP To verify this functionality, you must wire a testing device such 
as a stack light into digital output 2 and another device into 
digital output 3. You must also supply the required voltage  
terminals DOV+ and DOV-. 
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Review DataSite Workbench User Program

The sample DataSite Workbench project consists of four programs.

• Power Save - Saves power by turning power on/off to the LEDs, serial port, and RS485 port.
• Screen Builder Variables - Reads Meter Run 0 flow data variables and assigns a DataSite 

Workbench variable that can be used by the DataSite web pages.
• Digital Outputs - Controls DataSite digital outputs 2 and 3.
• Time Synchronization - Synchronizes the DataSite clock to the ControlLogix L63 controller 

clock.

Follow these steps to view the DataSite Workbench program in Run mode.

1. Compile the DataSite Workbench user program by clicking Rebuild Project/Library.

2. Click Debug Target.

This lets you view a running program and make changes to the variables.

3. In Debug mode, double-click the program you want to view.

4. Refer to the program comments for details on functionality.

To view other programs, close the program editor window and double-click a different program 
from the link architecture view.
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DataSite to FactoryTalk View ME Master

This appendix describes how to configure a PanelView Plus 600 terminal to communicate with 
the DataSite using Modbus serial communication. This setup requires KEPServerEnterprise V4.0 to 
configure drivers between the DataSite unit and the PanelView Plus terminal running FactoryTalk 
View ME.

Use this setup for smaller applications that don't require a ControlLogix controller to poll multiple 
DataSite units. Refer to Appendix B for instructions on how to configure a Factory Talk View SE 
master to communicate with the DataSite via Modbus TCP/IP communication that don’t require a 
controller but do require data logging parameters to an excel file.

Before You Begin

• Download KEPServer Enterprise V4.0.
• Wire the DataSite unit to the PanelView Plus 600 terminal using the 2711-NC13 serial cable.
• Apply Power to the DataSite unit and PanelView Plus 600 terminal.

What You Need

• Personal computer
• Hardware:

– DataSite unit
– PanelView Plus 600 terminal

2711-NC13 Serial Cable Ethernet Crossover Cable

Programming Computer 
Running 

FactoryTalk View ME

2711P PanelView Plus 600 Terminal 
with Built-in Ethernet Port

2711P-CBL-EX04
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– 2711C-NC13 serial cable
– 2711P-CBL-EX04 Ethernet crossover cable 

• Software:
– KEPServerEnterprise V4.0
– FactoryTalk View Studio ME
– DataSite Accelerator Toolkit CD, publication IASIMP-SP011

Follow These Steps

Load KEPServerEnterprise 
File

page 83

Load FactoryTalk View ME 
Application

page 85

Validate Communication 
Between DataSite and Terminal

page 88
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Load KEPServerEnterprise File

Follow these steps to load a KEPServer Enterprise .pfe file that contains Modbus addresses of the 
parameters to be polled and displayed on the PanelView Plus 600 HMI terminal.

1. From the DataSite Accelerator Toolkit CD, choose DataSite to FactoryTalk View ME 
Master>HMI Application files.

2. Copy ModbusSerial.pfe from the CD to the default project folder for KEPServerEnterprise.

3. Launch KEPServerEnterprise V4.0.

4. Choose Open from the File menu, then locate and open the ModbusSerial.pfe file.

C:\Program Files\KEPServerEnterprise\Projects
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5. From the Tools menu, 
Choose Options.

6. Click the Browse ... 
button to locate the 
default project 
ModbusSerial.pfe.

7. Click Apply.

8. Click OK.

C:\Program Files\KEPServerEnterprise\Projects\ModbusSerial.pfe
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Load FactoryTalk View ME Application

The FactoryTalk View ME application contains screens to display flow data on a PanelView Plus 
600 terminal for one meter run.

Follow these steps to load the FactoryTalk View ME application from the DataSite Accelerator 
Toolkit CD.

1. On the toolkit CD, choose DataSite to FactoryTalk View ME Master>HMI Application Files, 
then double-click DataSite_ME_Modbus_Serial.apa.

The Application Manager 
window opens.

2. Select Restore the FactoryTalk 
View Machine Edition 
application and click Next.
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3. Type DataSite_ME_Modbus_Serial 
as the application name, then click 
Finish.

The Application Manager closes 
after it restores the application.

4. Launch FactoryTalk View 
Studio software.

5. If this dialog box opens, select 
Machine Edition and click 
Continue.

DataSite_ME_Modbus_Serial
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6. Select DataSite_ME_Modbus_Serial 
from the Existing tab and click 
Open.

The FactoryTalk View ME 
application opens.

7. Create the .mer file and download to the PanelView Plus 600 terminal.

TIP Refer to Download Project to PanelView Plus Terminal on page 61 for details on how to 
create a runtime application and download the .mer application file to the PanelView 
Plus 600 terminal.
Publication IASIMP-QS008A-EN-P - March 2009 87



Appendix A        DataSite to FactoryTalk View ME Master
Validate Communication Between DataSite and Terminal

You are now ready to run the .mer application on the PanelView Plus 600 terminal, and validate 
communication with the DataSite unit. The KEPServer (.pfe) file polls 19 parameters for one 
meter run and displays the data on the PanelView Plus 600 terminal.

Follow these steps to validate Modbus Serial communication between the DataSite unit and 
PanelView Plus 600 terminal.

1. Make sure the COM1 or COM2 port of the DataSite is connected to the serial port of the 
PanelView Plus terminal by using a 2711-NC13 straight-through cable.

2. From the PanelView Plus 
terminal, press Load 
Application [F1] in the 
FactoryTalk View ME 
Station dialog box.

TIP The validation assumes that AGA calculations were initiated using instrumentation 
devices or simulated in DS FloConfig. Refer to Chapter 6 for more information on how to 
simulate the AGA process variables.

2711-NC13 Straight-through Cable

TIP If using radios, connect one serial radio to the DataSite and the 
other radio to the PanelView Plus 600 terminal.
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The Load Application dialog 
box opens.

3. Use the up/down arrows to 
scroll through the list of 
applications and select 
DataSite_ME_Modbus_Serial.

4. Press Load [F2].

5. Press Yes [F7].

If you press No, the 
communication settings from 
the previously run project will 
be used.
Publication IASIMP-QS008A-EN-P - March 2009 89



Appendix A        DataSite to FactoryTalk View ME Master
6. Wait for the application to the 
load and verify that 
DataSite_ME_Modbus_Serial.
mer appears under Current 
application.

7. Press Run Application [F2].

The application builds and displays 
a DataSite screen on the PanelView 
Plus terminal.

8. Press Process Variables & 
Compressibility.

Verify the process variables match 
the numbers simulated using DS 
FloConfig:
– Static Pressure = 800
– Temperature = 80
– Differential Pressure = 70

9. Return to the main screen and press the other two blue buttons to view accumulated flow 
data.

The flow data displayed is for Meter Run 0 (MR0). You can easily add other meter runs by adding 
the corresponding Modbus registers in the KEPServerEnterprise (.pfe) file. You must then 
duplicate the ME screens and change the tag names to match their corresponding tag name.

Configuration and validation of the DataSite to ME Master configuration is now complete.

IMPORTANT If the PanelView Plus terminal displays asterisks instead of data, then you need to select a different COM 
port for the Serial DF1 driver. Skip to page 91 for instructions on how to change the COM port.

2800

800
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Select a Different COM Port for the Serial DF1 Driver

If the variable data appears as asterisks on the PanelView Plus terminal, you need to change the 
COM port used by the serial DF1 driver. If data appears correctly on the terminal, you can skip 
this section.

Follow these steps to select a different COM port for the serial DF1 driver.

1. Press Terminal Settings 
[F4] in the FactoryTalk 
View ME Station dialog 
box.

2. Select Networks and 
Communications, then 
press the Enter button.
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3. Select RSLinx Enterprise 
Communications by 
pressing the cursor key, 
then press the Enter 
button.

4. Select Serial-DF1, then 
press Edit Driver [F2].
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5. Select COM Port, then 
press Edit [F1].

6. Select 2, then press OK 
[F7].
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7. Press the Cancel [F8] 
button until you return to 
the main menu.

8. Repeat steps 2 through 8 
starting on page 88 to 
validate the application.
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DataSite to FactoryTalk View SE Master

This appendix shows how to configure an industrial computer running FactoryTalk View SE 
software to communicate with a DataSite unit using Modbus TCP/IP communication. This setup 
requires KEPServerEnterprise software V4.0 to configure the communication driver.

This configuration is good for small applications that require data logging capabilities but don't 
require a ControlLogix controller to poll multiple DataSite units. Refer to Appendix A for details 
on how to configure a PanelView Plus terminal running Factory Talk View ME software to 
communicate with the DataSite using Modbus serial communication.

Before You Begin

• Download KEPServer Enterprise software V4.0.
• Connect the DataSite unit to an industrial computer running FactoryTalk View Site Edition 

(SE) software. 
• Radios are optional. 

6181P Industrial Computer Running 
FactoryTalk View SE

Radio
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Remote Location
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TIP Radios are optional. If your application does not require radios, simply replace the radios 
with an Ethernet crossover cable connecting the DataSite to the industrial computer.
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What You Need

• Hardware:
– DataSite unit
– 6181P industrial computer or personal computer
– Two radios, optional
– Two 2711P-CBL-EX04 Ethernet crossover cables 

• Software:
– KEPServerEnterprise V4.0
– FactoryTalk View SE
– DataSite Accelerator Toolkit CD, publication IASIMP-SP011

Follow These Steps

Load KEPServerEnterprise 
File

page 97

Load FactoryTalk View SE 
Application

page 99

Validate Communication 
Between DataSite and Computer

page 106
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Load KEPServerEnterprise File

Follow these steps to load a KEPServer Enterprise .pfe file that contains Modbus addresses of the 
parameters to be polled and displayed on the industrial computer. 

1. From the DataSite Accelerator Toolkit CD, choose DataSite to FactoryTalk View SE 
Master>HMI Application Files.

2. Copy ModbusEthernet.pfe from the CD to the default project folder for KEPServerEnterprise.

3. Launch KEPServerEnterprise software V4.0.

4. Choose Open from the File menu, then locate and open the ModbusEthernet.pfe file.

C:\Program Files\KEPServerEnterprise\Projects
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5. Choose Options from 
the Tools menu.

6. Click the Browse 
button ... to locate the 
default project 
ModbusEthernet.pfe.

7. Click Apply.

8. Click OK.

C:\Program Files\KEPServerEnterprise\Projects\ModbusEthernet.pfe
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Load FactoryTalk View SE Application

The FactoryTalk View SE application contains a screen that controls when to start and stop data 
logging to an Excel file. It also contains a screen with gas flow data for Meter Run 0. 

Follow these steps to load the FactoryTalk View SE application from the DataSite Accelerator 
Toolkit CD.

1. On the toolkit CD, choose DataSite to FactoryTalk View SE Master>HMI Application files, 
then double-click the DataSite_SE_Modbus_Ethernet.apa application file.
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The Application Manager 
window opens.

2. Select Restore the FactoryTalk 
View SE (local) application, then 
click Next.

3. Enter DataSite_ME_Modbus_Ethernet 
as the application name and click 
Finish.

The Application Manager closes after 
it restores the application.

DataSite_ME_Modbus_Ethernet
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4. Launch FactoryTalk View 
Studio software.

5. If this dialog box opens, select 
Site Edition (Local) and click 
Continue.

6. Select 
DataSite_SE_Modbus_Ethernet from 
the Existing tab and click Open.

The FactoryTalk View SE 
application opens.
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7. Click Launch SE Client on the 
toolbar.

8. Click New.

9. Click New.
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10. Enter DataSite_Client as the 
configuration file name, 
then click Next.

11. Select Local, then click 
Next.
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12. Select DataSite_SE_Modbus_Ethernet 
from the pull-down list or the name 
of the application assigned during 
the restore, then click Next.

13. Select Main from the Initial Display 
pull-down list, then click Next.
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14. Enter DataSite as the Title 
bar text and click Next.

15. Click Next.
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16. Select Save configuration and 
open FactoryTalk View SE Client 
now and click Finish.

Factory Talk View SE Client launches 
the application. Continue to the next 
section to validate communication 
and perform data logging.

Validate Communication Between DataSite and Computer

You are now ready to validate communication between the DataSite unit and the industrial 
computer. 

1. Press Meter Run.
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You should see a screen 
with gas flow values for 
Meter Run 0.

2. Verify the process 
variables are correct and 
press Main Menu.

3. Press Data Logging.

4. Press Datalog ON.

5. Allow data logging to run 
for about one or two  
minutes, then press 
Datalog OFF.
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6. On the toolkit CD, choose DataSite to FactoryTalk View SE Master>HMI Application files, 
then double-click RSView Enterprise File Viewer.

7. From the File menu, choose Open.

8. Drill down to the 
datalog folder and 
double-click it.

Default Location for datalog folder:
C:\Documents and Settings\All Users\Documents\RSView Enterprise\SE\HMI 
Projects\DataSite_SE_Modbus_Ethernet\DLGLOG\datalog
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9. Select the file with the latest date, where the format of the file name is 
YYYY MM DD 0000 (Float).DAT.
A file similar to this displays.

10. From the File menu, choose Save 
As.
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11. Enter a file name, then  
click Save.

The file is saved in a .csv 
format for viewing in 
Excel. 

12. Go to your desktop and 
locate the file just created. 

13. Double-click MeterRun0_Flow_Data.csv 
to view the data in Microsoft Excel.

14. View and manipulate the data if necessary.

You have just completed the setup and validation of the DataSite to Master SE configuration.
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Rockwell Automation 
Support

Rockwell Automation provides technical information on the Web to assist 
you in using its products. At http://support.rockwellautomation.com, you can 
find technical manuals, a knowledge base of FAQs, technical and application 
notes, sample code and links to software service packs, and a MySupport 
feature that you can customize to make the best use of these tools.

For an additional level of technical phone support for installation, 
configuration, and troubleshooting, we offer TechConnect support programs. 
For more information, contact your local distributor or Rockwell Automation 
representative, or visit http://support.rockwellautomation.com.

Installation Assistance

If you experience a problem within the first 24 hours of installation, please 
review the information that's contained in this manual. You can also contact a 
special Customer Support number for initial help in getting your product up 
and running.

New Product Satisfaction Return

Rockwell Automation tests all of its products to ensure that they are fully 
operational when shipped from the manufacturing facility. However, if your 
product is not functioning and needs to be returned, follow these 
procedures.

United States 1.440.646.3434
Monday – Friday, 8 a.m. – 5 p.m. EST

Outside United 
States

Please contact your local Rockwell Automation representative for any 
technical support issues.

United States Contact your distributor.  You must provide a Customer Support case 
number (see phone number above to obtain one) to your distributor in 
order to complete the return process.

Outside United 
States

Please contact your local Rockwell Automation representative for the 
return procedure.
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Intro

		Details of the Rockwell Automation Print Specifications sheet

				This print specifications sheet is designed with multiple purposes.
- It is a vehicle to get the most accurate print specifications to RA-approved print vendors.
- It provides authors with an explanation of all necessary fields to complete before attaching the sheet to your PDF.
- It provides separate tabs so that an author can fill in all fields related to the publication on the Generic tab or publication-specific template-type tabs to minimize the number of fields an author must complete.

To facilitate the most efficient use of this sheet, we recommend that you click on the publication-specific tab that most closely fits you publication and use that to complete the print specifications.

IMPORTANT: Because this sheet was constructed using a sheet that RR Donnelley (RRD) uses to load print specifications, there are some columns hidden. For example, the first field you must complete is Column E, or Publication Number. Columns A to D are used for RRD purposes and with information only representatives of that RA-approved printer can complete.

DO NOT delete any hidden columns from the tab you choose to use.

		Definitions of Each Tab in Sheet

		Generic pub print specs		Single sheet with all required columns for necessary specifications. None of the columns are completed. All must be completed before attaching the sheet to your PDF.

This tab has 39 blank fields you must complete via free text type or pull-down menus.

		IN, RN pub type specs		Templates with many fields already completed according to typical default settings. Use this tab with publications similar to installation instructions (IN) and release notes (RN). However, you can use this sheet for other publications that are similar to INs and RNs.

This sheet has several fields already completed with default values, which you can change. You must complete the additional fields.

		UM, RM, PM pub type specs		Templates with many fields already completed according to typical default settings. Use this tab with publications similar to user manuals (UM), reference manuals (RM) and programming manuals (PM). However, you can use this sheet for other publications that are similar to UMs, RMs and PMs.

This sheet has several fields already completed with default values, which you can change. You must complete the additional fields.

		AP, PP pub type specs		Templates with many fields already completed according to typical default settings. Use this tab with publications similar to application solutions (AP) and product profiles (PP). However, you can use this sheet for other publications that are similar to APs and PPs.

This sheet has several fields already completed with default values, which you can change. You must complete the additional fields.

		BR pub type specs		Templates with many fields already completed according to typical default settings. Use this tab with publications similar to brochures (BR). However, you can use this sheet for other publications that are similar to BRs.

This sheet has several fields already completed with default values, which you can change. You must complete the additional fields.

		Field definitions		Description of information fields used throughout the spreadsheet tabs that may not be immediately obvious to a user.

				Attach Print Specs to PDF

				For Acrobat 8.0, follow these steps:
1. Open the PDF.
2. Click on Document>Attach A File. A new section appears at the bottom of the PDF.
3. Browse to the MS Excel file with the print specs and add it to the PDF.

For Acrobat 7.0, follow these steps:
1. Open the PDF.
2. Click on the Attachments tab next to the publication's bookmarks. A new section appears at the bottom of the PDF.
3. Click on the Add button in the bottom section of the PDF.
4. Browse to the MS Excel file with the print specs and add it to the PDF.

For Acrobat 6.0, follow these steps:
1. Open the PDF.
2. Go to the backcover of the PDF.
3. Click on the Tools pull-down menu.
4. Click on this sequence of menu options - Advanced Commenting, Attach, Attach File Tool. A paper clip appears.
5. Click to put the paper clip somewhere on the backcover. The browse window appears.
6. Browse to the MS Excel file with the print specs and add it to the PDF.

IMPORTANT: If you are using Acrobat 5.0 or earlier, please upgrade.

				RA-QR005C-EN-E 6/08
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Generic pub print specs

IN, RN pub type specs

UM, RM, PM pub type specs

AP, PP pub type specs

BR pub type specs

Field definitions



Generic pub print specs

		Corp #		17501

		Bill To		69

		dPrint?		Content/Comp #		Split Shipment Indicator Flag		WCSS Item Number		Customer Item Number		Item Description		Producing Plant		Job Number		Replenishing Plant		Plant Code		Product Code		Packaging/Ordering UOM		Qty per Packaging/Ordering UOM		List Price Per Ea		Transfer Cost per Ea		Sell Price per Ea		Standard Cost (per Ea)		Min Order Qty (in eaches)		Multiple Order Qty (in Eaches		Chargeback Price		Item Reference #1		Item Reference #2		Revision Field		Max Order Qty (in eaches)		Sequentially Numbered Item?		Sequentially Numbered Item - Details		Priced for Digital or Offset		Content File Location		Item Category Form (F)  Book (B)		Item Subtype		Orientation		Sides Printed		CSS/JLS Stock     Componet		Paper Size Width		Paper Size Length		No of Forms to a Sheet		Page Qty		Sheets Qty		CSS/JLS Production Stock		Paper Stock Type		Paper Stock Weight		Paper Stock Color		Stack Offset		Tab Size		# of Tabs		Binder Size		Binder Color		Binder Ring Type		Binder Transparency (clearview or matt)		Thermal Tape Color		Trim Size Width		Trim Size Length		Stitching Location		Drilling Size		Drilling Location		Glue Location		# / Pad		Fold Type		Fold At		# / Poly		# / Box		Comments		Cross Reference Item Number 1

										Publication Number		Publication Title												Packaging/Ordering Unit Of Measure		Qty per Packaging/Ordering Unit of Measure										Min Order Qty		Multiple Order Qty				Business Group		Cost Center		Revision Date		Max Order Qty						Black & White
or Color				Item Category
Form (F) or Book (B)		Binding/Stitching		Orientation		Sides Printed				Printing Paper Size Width		Printing Paper Size Length		Number of Forms to a Sheet		Page Count of Publication		Number of Sheets Required to Print		CSS/JLS Production Stock		Paper Stock Type		Paper Stock Weight		Paper Stock Color		Stack Offset		Tab Size		Number of Tabs Needed		Binder Size		Binder Color		Binder Ring Type		Binder Transparency		Thermal Tape Color		Finished Trim Size Width		Finished Trim Size Length		Stitching Location		Drill Hole Size		Number and Location of Drill Holes		Glue Location		Number of Pages per Pad		Fold Type		Fold At		Number of Pieces per Poly wrap		Number of Pieces per Box		Comments		Part Number

		Are these items being setup on dPrint? (Yes or No). If yes, Inv Mgmt to check "Print Management" flag on item setup.		The content/Comp # will be provided by the CSC once the spec files are loaded to the DAS (the files must be named with the WCSS item #). The content/comp# must be hardcoded to the Item message Field in WCSS. Must be a 10 Digit number that starts with an 8.		Required. Setting this to yes will allow warehouse product to ship out before the JIT item is completed. Setting this to no will hold all warehoused items until the printing of this item is complete. Please indicate Y or N.** Note: Each item with a Y will always ship separately even if produced at the same time as like items.		Optional. 15 Characters Max. If the WCSS number provided already exists in the system, then Inventory Management will assign a random WCSS number.		30 characters maximum.		Cannot use quote symbol, that is--"--.		Required.  Which plant/Print Center will produce this item?		Required. To be provided from the producing plant for JIT s/u		Required: What is the plant code of the plant that has owning rights to the dPrint files? If produced at multiple plants there can be only one owning plant.		Required. What is the plant code of the facility that will produce this item? (see "Plant and Whse Codes" tab below)		Required. Enter one of the applicable product.		Method of packaging for publication shipment

Click here for explanation of each value in the pull-down				Required.  This field auto-calculates (transfer cost divided by .5). Used to determine Standard Cost on WCSS (which is 50% of the list price for these product codes).		Required. Transfer Cost per ordering/packaging unit of measure.		Required. Price that will be billed to customer upon order.  If Price Breaks, enter "Price Breaks" and note them on separate spreadsheet.		Required. Replacement Cost per Packaging/ordering UOM.				Click here for an explanation of this field; otherwise, type NA.		Optional.  Used to assist customer with internal Chargebacks to end users. (per packaging/ordering UOM)		IMPORTANT: This information must match the DocMan record.

Click here for explanation of each value in the pull-down menu.		IMPORTANT: This information must match the DocMan record.		IMPORTANT: This information must match the DocMan record.

Date on the publication.		Click here for explanation of each value in the pull-down menu.		Indicate Yes or No.  
Enter Yes if the item is a sequentially numbered item.		Describe the details behind the sequentially numbered item, such as:
- Record Sequence Shipped: whse will record the sequence numbers that shipped
- Ship in Sequence Record: required to ship products in particular sequence and the whse records the numbers				Required:                If PDF is to be retained in the DAS enter DAS in this field, if item is part of eCreate or Custom Docs put CUSTOM in this field.		Typically a Book.

Click here for explanation of each value in the pull-down menu.		Click here for explanation of each value in the pull-down				Click here for explanation of each value in the pull-down menu.		Optional: Use when finished product stored in the warehouse is to be inserted into the construction of a JIT book.		IMPORTANT: Not Trim Size width

This is the width of the paper on which the publication is printed.		IMPORTANT: Not Trim Size length

This is the length of the paper on which the publication is printed.		Click here for explanation of how to determine the information required.				Click here for explanation of how to determine the information required.		Optional:              Use when product is being printed on Shell Stock. Provide warehoused WCSS Item nu,mber of product to be used in the production of JIT item.		Click here for explanation of how to determine the information required.				The pull-down menu lists the most common choices.

Click here for a full list of the available choices.

If you use a choice not in the pull-down list, type the value in the cell below the pull-down menu.				If item uses tabs; otherwise, NA.		If needed; otherwise type NA.		If item used in a binder; otherwise, NA.		If item used in a binder; otherwise, NA.		If item used in a binder; otherwise, NA.		If item used in a binder; otherwise, NA.		If publication is thermal tape bound; otherwise, NA.		Click here to see the available finished trim sizes.

The sizes are listed - width x length.		Click here to see the available finished trim sizes.

The sizes are listed - width x length.		If publication is Book [B] and stapled; otherwise, NA.				Click here for a list of possible drill locations		If publication uses padding; otherwise, NA.		If publication is a notepad or message pad; otherwise, NA.		Click here for explanation of each value in the pull-down menu.  Folding of final document optional		The location(s) of the fold		Click here for explanation of each value in the pull-down menu.				Use this column to list:
- Cover Stock
- Text Stock
- Cover Ink
- Text Ink
- Spine, if necessary

Also use to indicate any other production or finishing requirements not provided in previous columns

Click here for an explanation of the available Cover Stock, Cover Ink and Text Ink values.		List only if pubication is used in manufacturing; otherwise, leave blank.

																																												See DocMan for the Cost Center selections associated with each Business Group.																								RRD must provide this information		RRD must provide this information																RRD must provide this information																																				RRD must provide this information
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Click here for explanation of each value in the pull-down

Method of packaging for publication shipment

Click here for explanation of each value in the pull-down

IMPORTANT: This information must match the DocMan record.

Click here for explanation of each value in the pull-down menu.

Click here for explanation of each value in the pull-down menu.

Typically a Book.

Click here for explanation of each value in the pull-down menu.

Click here for explanation of each value in the pull-down menu.

Click here for explanation of how to determine the information required.

Click here for explanation of how to determine the information required.

Click here for explanation of how to determine the information required.

The pull-down menu lists the most common choices.

Click here for a full list of the available choices.

If you use a choice not in the pull-down list, type the value in the cell below the pull-down menu.

Click here to see the available finished trim sizes.

The sizes are listed - width x length.

Click here to see the available finished trim sizes.

The sizes are listed - width x length.

Click here for a list of possible drill locations

Click here for explanation of each value in the pull-down menu.  Folding of final document optional

Click here for explanation of each value in the pull-down menu.

Use this column to list:
- Cover Stock
- Text Stock
- Cover Ink
- Text Ink
- Spine, if necessary

Also use to indicate any other production or finishing requirements not provided in previous columns

Click here for an explanation of the available Cover Stock, Cover Ink and Text Ink values.

Click here for an explanation of this field; otherwise, type NA.



IN, RN pub type specs

		dPrint?		Content/Comp #		Split Shipment Indicator Flag		WCSS Item Number		Customer Item Number		Item Description		Producing Plant		Job Number		Replenishing Plant		Plant Code		Product Code		Packaging/Ordering UOM		Qty per Packaging/Ordering UOM		List Price Per Ea		Transfer Cost per Ea		Sell Price per Ea		Standard Cost (per Ea)		Min Order Qty (in eaches)		Multiple Order Qty (in Eaches		Chargeback Price		Item Reference #1		Item Reference #2		Revision Field		Max Order Qty (in eaches)		Sequentially Numbered Item?		Sequentially Numbered Item - Details		Priced for Digital or Offset		Content File Location		Item Category Form (F)  Book (B)		Item Subtype		Orientation		Sides Printed		CSS/JLS Stock     Componet		Paper Size Width		Paper Size Length		No of Forms to a Sheet		Page Qty		Sheets Qty		CSS/JLS Production Stock		Paper Stock Type		Paper Stock Weight		Paper Stock Color		Stack Offset		Tab Size		# of Tabs		Binder Size		Binder Color		Binder Ring Type		Binder Transparency (clearview or matt)		Thermal Tape Color		Trim Size Width		Trim Size Length		Stitching Location		Drilling Size		Drilling Location		Glue Location		# / Pad		Fold Type		Fold At		# / Poly		# / Box		Comments		Cross Reference Item Number 1

										Publication Number		Publication Title												Packaging/Ordering Unit Of Measure		Qty per Packaging/Ordering Unit of Measure										Min Order Qty		Multiple Order Qty				Business Group		Cost Center		Revision Date		Max Order Qty						Black & White
or Color				Item Category
Form (F) or Book (B)		Binding/Stitching		Orientation		Sides Printed				Printing Paper Size Width		Printing Paper Size Length		Number of Forms to a Sheet		Page Count of Publication		Number of Sheets Required to Print		CSS/JLS Production Stock		Paper Stock Type		Paper Stock Weight		Paper Stock Color		Stack Offset		Tab Size		Number of Tabs Needed		Binder Size		Binder Color		Binder Ring Type		Binder Transparency		Thermal Tape Color		Finished Trim Size Width		Finished Trim Size Length		Stitching Location		Drill Hole Size		Number and Location of Drill Holes		Glue Location		Number of Pages per Pad		Fold Type		Fold At		Number of Pieces per Poly wrap		Number of Pieces per Box		Comments		Part Number

		Are these items being setup on dPrint? (Yes or No). If yes, Inv Mgmt to check "Print Management" flag on item setup.		The content/Comp # will be provided by the CSC once the spec files are loaded to the DAS (the files must be named with the WCSS item #). The content/comp# must be hardcoded to the Item message Field in WCSS. Must be a 10 Digit number that starts with an 8.		Required. Setting this to yes will allow warehouse product to ship out before the JIT item is completed. Setting this to no will hold all warehoused items until the printing of this item is complete. Please indicate Y or N.** Note: Each item with a Y will always ship separately even if produced at the same time as like items.		Optional. 15 Characters Max. If the WCSS number provided already exists in the system, then Inventory Management will assign a random WCSS number.		30 characters maximum.		Cannot use quote symbol, that is--"--.		Required.  Which plant/Print Center will produce this item?		Required. To be provided from the producing plant for JIT s/u		Required: What is the plant code of the plant that has owning rights to the dPrint files? If produced at multiple plants there can be only one owning plant.		Required. What is the plant code of the facility that will produce this item? (see "Plant and Whse Codes" tab below)		Required. Enter one of the applicable product.		Method of packaging for publication shipment

Click here for explanation of each value in the pull-down				Required.  This field auto-calculates (transfer cost divided by .5). Used to determine Standard Cost on WCSS (which is 50% of the list price for these product codes).		Required. Transfer Cost per ordering/packaging unit of measure.		Required. Price that will be billed to customer upon order.  If Price Breaks, enter "Price Breaks" and note them on separate spreadsheet.		Required. Replacement Cost per Packaging/ordering UOM.				Click here for an explanation of this field; otherwise, type NA.		Optional.  Used to assist customer with internal Chargebacks to end users. (per packaging/ordering UOM)		IMPORTANT: This information must match the DocMan record.

Click here for explanation of each value in the pull-down menu.		IMPORTANT: This information must match the DocMan record.		IMPORTANT: This information must match the DocMan record.

Date on the publication.		Click here for explanation of each value in the pull-down menu.		Indicate Yes or No.  
Enter Yes if the item is a sequentially numbered item.		Describe the details behind the sequentially numbered item, such as:
- Record Sequence Shipped: whse will record the sequence numbers that shipped
- Ship in Sequence Record: required to ship products in particular sequence and the whse records the numbers				Required:                If PDF is to be retained in the DAS enter DAS in this field, if item is part of eCreate or Custom Docs put CUSTOM in this field.		Typically a Book.

Click here for explanation of each value in the pull-down menu.		Click here for explanation of each value in the pull-down				Click here for explanation of each value in the pull-down menu.		Optional: Use when finished product stored in the warehouse is to be inserted into the construction of a JIT book.		IMPORTANT: Not Trim Size width

This is the width of the paper on which the publication is printed.		IMPORTANT: Not Trim Size length

This is the length of the paper on which the publication is printed.		Click here for explanation of how to determine the information required.				Click here for explanation of how to determine the information required.		Optional:              Use when product is being printed on Shell Stock. Provide warehoused WCSS Item nu,mber of product to be used in the production of JIT item.		Click here for explanation of how to determine the information required.				The pull-down menu lists the most common choices.

Click here for a full list of the available choices.

If you use a choice not in the pull-down list, type the value in the cell below the pull-down menu.				If item uses tabs; otherwise, NA.		If needed; otherwise type NA.		If item used in a binder; otherwise, NA.		If item used in a binder; otherwise, NA.		If item used in a binder; otherwise, NA.		If item used in a binder; otherwise, NA.		If publication is thermal tape bound; otherwise, NA.		Click here to see the available finished trim sizes.

The sizes are listed - width x length.		Click here to see the available finished trim sizes.

The sizes are listed - width x length.		If publication is Book [B] and stapled; otherwise, NA.				Click here for a list of possible drill locations		If publication uses padding; otherwise, NA.		If publication is a notepad or message pad; otherwise, NA.		Click here for explanation of each value in the pull-down menu. 
Folding of final document optional		The location(s) of the fold		Click here for explanation of each value in the pull-down menu.				Use this column to list:
- Cover Stock
- Text Stock
- Cover Ink
- Text Ink
- Spine, if necessary

Also use to indicate any other production or finishing requirements not provided in previous columns

Click here for an explanation of the available Cover Stock, Cover Ink and Text Ink values.		List only if pubication is used in manufacturing; otherwise, leave blank.

																								EA												1		1				Marketing Commercial		See DocMan for the Cost Center selections associated with each Business Group.										Black & White				B		SADDLE		PORTRAIT		HEAD2HEAD				RRD must provide this information		RRD must provide this information										PLAIN		20#		White		RRD must provide this information		NA		NA		NA		NA		NA		NA		BLACK (preferred)						SIDE		NA		NA		NA		NA		HALF				50		RRD must provide this information		Text Stock = 20# White Opaque Bond
Text Ink = Black



Click here for explanation of each value in the pull-down

Method of packaging for publication shipment

Click here for explanation of each value in the pull-down

IMPORTANT: This information must match the DocMan record.

Click here for explanation of each value in the pull-down menu.

Click here for explanation of each value in the pull-down menu.

Typically a Book.

Click here for explanation of each value in the pull-down menu.

Click here for explanation of each value in the pull-down menu.

Click here for explanation of how to determine the information required.

Click here for explanation of how to determine the information required.

Click here for explanation of how to determine the information required.

The pull-down menu lists the most common choices.

Click here for a full list of the available choices.

If you use a choice not in the pull-down list, type the value in the cell below the pull-down menu.

Click here to see the available finished trim sizes.

The sizes are listed - width x length.

Click here to see the available finished trim sizes.

The sizes are listed - width x length.

Click here for a list of possible drill locations

Click here for explanation of each value in the pull-down menu.

Use this column to list:
- Cover Stock
- Text Stock
- Cover Ink
- Text Ink
- Spine, if necessary

Also use to indicate any other production or finishing requirements not provided in previous columns

Click here for an explanation of the available Cover Stock, Cover Ink and Text Ink values.

Click here for an explanation of this field; otherwise, type NA.

Click here for explanation of each value in the pull-down menu. 
Folding of final document optional



UM, RM, PM pub type specs

		dPrint?		Content/Comp #		Split Shipment Indicator Flag		WCSS Item Number		Customer Item Number		Item Description		Producing Plant		Job Number		Replenishing Plant		Plant Code		Product Code		Packaging/Ordering UOM		Qty per Packaging/Ordering UOM		List Price Per Ea		Transfer Cost per Ea		Sell Price per Ea		Standard Cost (per Ea)		Min Order Qty (in eaches)		Multiple Order Qty (in Eaches		Chargeback Price		Item Reference #1		Item Reference #2		Revision Field		Max Order Qty (in eaches)		Sequentially Numbered Item?		Sequentially Numbered Item - Details		Priced for Digital or Offset		Content File Location		Item Category Form (F)  Book (B)		Item Subtype		Orientation		Sides Printed		CSS/JLS Stock     Componet		Paper Size Width		Paper Size Length		No of Forms to a Sheet		Page Qty		Sheets Qty		CSS/JLS Production Stock		Paper Stock Type		Paper Stock Weight		Paper Stock Color		Stack Offset		Tab Size		# of Tabs		Binder Size		Binder Color		Binder Ring Type		Binder Transparency (clearview or matt)		Thermal Tape Color		Trim Size Width		Trim Size Length		Stitching Location		Drilling Size		Drilling Location		Glue Location		# / Pad		Fold Type		Fold At		# / Poly		# / Box		Comments		Cross Reference Item Number 1

										Publication Number		Publication Title												Packaging/Ordering Unit Of Measure		Qty per Packaging/Ordering Unit of Measure										Min Order Qty		Multiple Order Qty				Business Group		Cost Center		Revision Date		Max Order Qty						Black & White
or Color				Item Category
Form (F) or Book (B)		Binding/Stitching		Orientation		Sides Printed				Printing Paper Size Width		Printing Paper Size Length		Number of Forms to a Sheet		Page Count of Publication		Number of Sheets Required to Print		CSS/JLS Production Stock		Paper Stock Type		Paper Stock Weight		Paper Stock Color		Stack Offset		Tab Size		Number of Tabs Needed		Binder Size		Binder Color		Binder Ring Type		Binder Transparency		Thermal Tape Color		Finished Trim Size Width		Finished Trim Size Length		Stitching Location		Drill Hole Size		Number and Location of Drill Holes		Glue Location		Number of Pages per Pad		Fold Type		Fold At		Number of Pieces per Poly wrap		Number of Pieces per Box		Comments		Part Number

		Are these items being setup on dPrint? (Yes or No). If yes, Inv Mgmt to check "Print Management" flag on item setup.		The content/Comp # will be provided by the CSC once the spec files are loaded to the DAS (the files must be named with the WCSS item #). The content/comp# must be hardcoded to the Item message Field in WCSS. Must be a 10 Digit number that starts with an 8.		Required. Setting this to yes will allow warehouse product to ship out before the JIT item is completed. Setting this to no will hold all warehoused items until the printing of this item is complete. Please indicate Y or N.** Note: Each item with a Y will always ship separately even if produced at the same time as like items.		Optional. 15 Characters Max. If the WCSS number provided already exists in the system, then Inventory Management will assign a random WCSS number.		30 characters maximum.		Cannot use quote symbol, that is--"--.		Required.  Which plant/Print Center will produce this item?		Required. To be provided from the producing plant for JIT s/u		Required: What is the plant code of the plant that has owning rights to the dPrint files? If produced at multiple plants there can be only one owning plant.		Required. What is the plant code of the facility that will produce this item? (see "Plant and Whse Codes" tab below)		Required. Enter one of the applicable product.		Method of packaging for publication shipment

Click here for explanation of each value in the pull-down				Required.  This field auto-calculates (transfer cost divided by .5). Used to determine Standard Cost on WCSS (which is 50% of the list price for these product codes).		Required. Transfer Cost per ordering/packaging unit of measure.		Required. Price that will be billed to customer upon order.  If Price Breaks, enter "Price Breaks" and note them on separate spreadsheet.		Required. Replacement Cost per Packaging/ordering UOM.				Click here for an explanation of this field; otherwise, type NA.		Optional.  Used to assist customer with internal Chargebacks to end users. (per packaging/ordering UOM)		IMPORTANT: This information must match the DocMan record.

Click here for explanation of each value in the pull-down menu.		IMPORTANT: This information must match the DocMan record.		IMPORTANT: This information must match the DocMan record.

Date on the publication.		Click here for explanation of each value in the pull-down menu.		Indicate Yes or No.  
Enter Yes if the item is a sequentially numbered item.		Describe the details behind the sequentially numbered item, such as:
- Record Sequence Shipped: whse will record the sequence numbers that shipped
- Ship in Sequence Record: required to ship products in particular sequence and the whse records the numbers				Required:                If PDF is to be retained in the DAS enter DAS in this field, if item is part of eCreate or Custom Docs put CUSTOM in this field.		Typically a Book.

Click here for explanation of each value in the pull-down menu.		Click here for explanation of each value in the pull-down				Click here for explanation of each value in the pull-down menu.		Optional: Use when finished product stored in the warehouse is to be inserted into the construction of a JIT book.		IMPORTANT: Not Trim Size width

This is the width of the paper on which the publication is printed.		IMPORTANT: Not Trim Size length

This is the length of the paper on which the publication is printed.		Click here for explanation of how to determine the information required.				Click here for explanation of how to determine the information required.		Optional:              Use when product is being printed on Shell Stock. Provide warehoused WCSS Item nu,mber of product to be used in the production of JIT item.		Click here for explanation of how to determine the information required.				The pull-down menu lists the most common choices.

Click here for a full list of the available choices.

If you use a choice not in the pull-down list, type the value in the cell below the pull-down menu.				If item uses tabs; otherwise, NA.		If needed; otherwise type NA.		If item used in a binder; otherwise, NA.		If item used in a binder; otherwise, NA.		If item used in a binder; otherwise, NA.		If item used in a binder; otherwise, NA.		If publication is thermal tape bound; otherwise, NA.		Click here to see the available finished trim sizes.

The sizes are listed - width x length.		Click here to see the available finished trim sizes.

The sizes are listed - width x length.		If publication is Book [B] and stapled; otherwise, NA.				Click here for a list of possible drill locations		If publication uses padding; otherwise, NA.		If publication is a notepad or message pad; otherwise, NA.		Click here for explanation of each value in the pull-down menu. 
Folding of final document optional		The location(s) of the fold		Click here for explanation of each value in the pull-down menu.				Use this column to list:
- Cover Stock
- Text Stock
- Cover Ink
- Text Ink
- Spine, if necessary

Also use to indicate any other production or finishing requirements not provided in previous columns

Click here for an explanation of the available Cover Stock, Cover Ink and Text Ink values.		List only if pubication is used in manufacturing; otherwise, leave blank.

										IASIMP-QS008A-EN-P		DataSite Accelerator Toolkit Quick Start												EA												1		1				CMKMKE Print & Dist (RA Brand Only)		19083		03/01/2009								Black & White				B		PERFECT		PORTRAIT		HEAD2HEAD				RRD must provide this information		RRD must provide this information		4		112		28				PLAIN		20#		White		RRD must provide this information		NA		NA		NA		NA		NA		NA		NA		8.5		11		NA		5/16"		3LEFT		NA		NA		NA		NA				RRD must provide this information		Cover Stock = 90# White Index
Text Stock = 20# White Opaque Bond
Cover Ink = Black
Text Ink = Black
Note: Previous warehoused doc was saddle-stitched.



Click here for explanation of each value in the pull-down

Method of packaging for publication shipment

Click here for explanation of each value in the pull-down

IMPORTANT: This information must match the DocMan record.

Click here for explanation of each value in the pull-down menu.

Click here for explanation of each value in the pull-down menu.

Typically a Book.

Click here for explanation of each value in the pull-down menu.

Click here for explanation of each value in the pull-down menu.

Click here for explanation of how to determine the information required.

Click here for explanation of how to determine the information required.

Click here for explanation of how to determine the information required.

The pull-down menu lists the most common choices.

Click here for a full list of the available choices.

If you use a choice not in the pull-down list, type the value in the cell below the pull-down menu.

Click here to see the available finished trim sizes.

The sizes are listed - width x length.

Click here to see the available finished trim sizes.

The sizes are listed - width x length.

Click here for a list of possible drill locations

Click here for explanation of each value in the pull-down menu.

Use this column to list:
- Cover Stock
- Text Stock
- Cover Ink
- Text Ink
- Spine, if necessary

Also use to indicate any other production or finishing requirements not provided in previous columns

Click here for an explanation of the available Cover Stock, Cover Ink and Text Ink values.

Click here for an explanation of this field; otherwise, type NA.

Click here for explanation of each value in the pull-down menu. 
Folding of final document optional



AP, PP pub type specs

		dPrint?		Content/Comp #		Split Shipment Indicator Flag		WCSS Item Number		Customer Item Number		Item Description		Producing Plant		Job Number		Replenishing Plant		Plant Code		Product Code		Packaging/Ordering UOM		Qty per Packaging/Ordering UOM		List Price Per Ea		Transfer Cost per Ea		Sell Price per Ea		Standard Cost (per Ea)		Min Order Qty (in eaches)		Multiple Order Qty (in Eaches		Chargeback Price		Item Reference #1		Item Reference #2		Revision Field		Max Order Qty (in eaches)		Sequentially Numbered Item?		Sequentially Numbered Item - Details		Priced for Digital or Offset		Content File Location		Item Category Form (F)  Book (B)		Item Subtype		Orientation		Sides Printed		CSS/JLS Stock     Componet		Paper Size Width		Paper Size Length		No of Forms to a Sheet		Page Qty		Sheets Qty		CSS/JLS Production Stock		Paper Stock Type		Paper Stock Weight		Paper Stock Color		Stack Offset		Tab Size		# of Tabs		Binder Size		Binder Color		Binder Ring Type		Binder Transparency (clearview or matt)		Thermal Tape Color		Trim Size Width		Trim Size Length		Stitching Location		Drilling Size		Drilling Location		Glue Location		# / Pad		Fold Type		Fold At		# / Poly		# / Box		Comments		Cross Reference Item Number 1

										Publication Number		Publication Title												Packaging/Ordering Unit Of Measure		Qty per Packaging/Ordering Unit of Measure										Min Order Qty		Multiple Order Qty				Business Group		Cost Center		Revision Date		Max Order Qty						Black & White
or Color				Item Category
Form (F) or Book (B)		Binding/Stitching		Orientation		Sides Printed				Printing Paper Size Width		Printing Paper Size Length		Number of Forms to a Sheet		Page Count of Publication		Number of Sheets Required to Print		CSS/JLS Production Stock		Paper Stock Type		Paper Stock Weight		Paper Stock Color		Stack Offset		Tab Size		Number of Tabs Needed		Binder Size		Binder Color		Binder Ring Type		Binder Transparency		Thermal Tape Color		Finished Trim Size Width		Finished Trim Size Length		Stitching Location		Drill Hole Size		Number and Location of Drill Holes		Glue Location		Number of Pages per Pad		Fold Type		Fold At		Number of Pieces per Poly wrap		Number of Pieces per Box		Comments		Part Number

		Are these items being setup on dPrint? (Yes or No). If yes, Inv Mgmt to check "Print Management" flag on item setup.		The content/Comp # will be provided by the CSC once the spec files are loaded to the DAS (the files must be named with the WCSS item #). The content/comp# must be hardcoded to the Item message Field in WCSS. Must be a 10 Digit number that starts with an 8.		Required. Setting this to yes will allow warehouse product to ship out before the JIT item is completed. Setting this to no will hold all warehoused items until the printing of this item is complete. Please indicate Y or N.** Note: Each item with a Y will always ship separately even if produced at the same time as like items.		Optional. 15 Characters Max. If the WCSS number provided already exists in the system, then Inventory Management will assign a random WCSS number.		30 characters maximum.		Cannot use quote symbol, that is--"--.		Required.  Which plant/Print Center will produce this item?		Required. To be provided from the producing plant for JIT s/u		Required: What is the plant code of the plant that has owning rights to the dPrint files? If produced at multiple plants there can be only one owning plant.		Required. What is the plant code of the facility that will produce this item? (see "Plant and Whse Codes" tab below)		Required. Enter one of the applicable product.		Method of packaging for publication shipment

Click here for explanation of each value in the pull-down				Required.  This field auto-calculates (transfer cost divided by .5). Used to determine Standard Cost on WCSS (which is 50% of the list price for these product codes).		Required. Transfer Cost per ordering/packaging unit of measure.		Required. Price that will be billed to customer upon order.  If Price Breaks, enter "Price Breaks" and note them on separate spreadsheet.		Required. Replacement Cost per Packaging/ordering UOM.				Click here for an explanation of this field; otherwise, type NA.		Optional.  Used to assist customer with internal Chargebacks to end users. (per packaging/ordering UOM)		IMPORTANT: This information must match the DocMan record.

Click here for explanation of each value in the pull-down menu.		IMPORTANT: This information must match the DocMan record.		IMPORTANT: This information must match the DocMan record.

Date on the publication.		Click here for explanation of each value in the pull-down menu.		Indicate Yes or No.  
Enter Yes if the item is a sequentially numbered item.		Describe the details behind the sequentially numbered item, such as:
- Record Sequence Shipped: whse will record the sequence numbers that shipped
- Ship in Sequence Record: required to ship products in particular sequence and the whse records the numbers				Required:                If PDF is to be retained in the DAS enter DAS in this field, if item is part of eCreate or Custom Docs put CUSTOM in this field.		Typically a Book.

Click here for explanation of each value in the pull-down menu.		Click here for explanation of each value in the pull-down				Click here for explanation of each value in the pull-down menu.		Optional: Use when finished product stored in the warehouse is to be inserted into the construction of a JIT book.		IMPORTANT: Not Trim Size width

This is the width of the paper on which the publication is printed.		IMPORTANT: Not Trim Size length

This is the length of the paper on which the publication is printed.		Click here for explanation of how to determine the information required.				Click here for explanation of how to determine the information required.		Optional:              Use when product is being printed on Shell Stock. Provide warehoused WCSS Item nu,mber of product to be used in the production of JIT item.		Click here for explanation of how to determine the information required.				The pull-down menu lists the most common choices.

Click here for a full list of the available choices.

If you use a choice not in the pull-down list, type the value in the cell below the pull-down menu.				If item uses tabs; otherwise, NA.		If needed; otherwise type NA.		If item used in a binder; otherwise, NA.		If item used in a binder; otherwise, NA.		If item used in a binder; otherwise, NA.		If item used in a binder; otherwise, NA.		If publication is thermal tape bound; otherwise, NA.		Click here to see the available finished trim sizes.

The sizes are listed - width x length.		Click here to see the available finished trim sizes.

The sizes are listed - width x length.		If publication is Book [B] and stapled; otherwise, NA.				Click here for a list of possible drill locations		If publication uses padding; otherwise, NA.		If publication is a notepad or message pad; otherwise, NA.		Click here for explanation of each value in the pull-down menu. 
Folding of final document optional		The location(s) of the fold		Click here for explanation of each value in the pull-down menu.				Use this column to list:
- Cover Stock
- Text Stock
- Cover Ink
- Text Ink
- Spine, if necessary

Also use to indicate any other production or finishing requirements not provided in previous columns

Click here for an explanation of the available Cover Stock, Cover Ink and Text Ink values.		List only if pubication is used in manufacturing; otherwise, leave blank.

																								PK												1								See DocMan for the Cost Center selections associated with each Business Group.										Color				B		NA		PORTRAIT		HEAD2HEAD				RRD must provide this information		RRD must provide this information										GLOSS TEXT		80#		White		RRD must provide this information		NA		NA		NA		NA		NA		NA		NA		8.5		11		NA		NA				NA		NA		HALF		8.5 x 11				RRD must provide this information



Click here for explanation of each value in the pull-down

Method of packaging for publication shipment

Click here for explanation of each value in the pull-down

IMPORTANT: This information must match the DocMan record.

Click here for explanation of each value in the pull-down menu.

Click here for explanation of each value in the pull-down menu.

Typically a Book.

Click here for explanation of each value in the pull-down menu.

Click here for explanation of each value in the pull-down menu.

Click here for explanation of how to determine the information required.

Click here for explanation of how to determine the information required.

Click here for explanation of how to determine the information required.

The pull-down menu lists the most common choices.

Click here for a full list of the available choices.

If you use a choice not in the pull-down list, type the value in the cell below the pull-down menu.

Click here to see the available finished trim sizes.

The sizes are listed - width x length.

Click here to see the available finished trim sizes.

The sizes are listed - width x length.

Click here for a list of possible drill locations

Click here for explanation of each value in the pull-down menu.

Use this column to list:
- Cover Stock
- Text Stock
- Cover Ink
- Text Ink
- Spine, if necessary

Also use to indicate any other production or finishing requirements not provided in previous columns

Click here for an explanation of the available Cover Stock, Cover Ink and Text Ink values.

Click here for an explanation of this field; otherwise, type NA.

Click here for explanation of each value in the pull-down menu. 
Folding of final document optional



BR pub type specs

		dPrint?		Content/Comp #		Split Shipment Indicator Flag		WCSS Item Number		Customer Item Number		Cannot use quote symbol, that is--"--.		Producing Plant		Job Number		Replenishing Plant		Plant Code		Product Code		Packaging/Ordering UOM		Qty per Packaging/Ordering UOM		List Price Per Ea		Transfer Cost per Ea		Sell Price per Ea		Standard Cost (per Ea)		Min Order Qty (in eaches)		Multiple Order Qty (in Eaches		Chargeback Price		Item Reference #1		Item Reference #2		Revision Field		Max Order Qty (in eaches)		Sequentially Numbered Item?		Sequentially Numbered Item - Details		Priced for Digital or Offset		Content File Location		Item Category Form (F)  Book (B)		Item Subtype		Orientation		Sides Printed		CSS/JLS Stock     Componet		Paper Size Width		Paper Size Length		No of Forms to a Sheet		Page Qty		Sheets Qty		CSS/JLS Production Stock		Paper Stock Type		Paper Stock Weight		Paper Stock Color		Stack Offset		Tab Size		# of Tabs		Binder Size		Binder Color		Binder Ring Type		Binder Transparency (clearview or matt)		Thermal Tape Color		Trim Size Width		Trim Size Length		Stitching Location		Drilling Size		Drilling Location		Glue Location		# / Pad		Fold Type		Fold At		# / Poly		# / Box		Comments		Cross Reference Item Number 1

										Publication Number		Publication Title												Packaging/Ordering Unit Of Measure		Qty per Packaging/Ordering Unit of Measure										Min Order Qty		Multiple Order Qty				Business Group		Cost Center		Revision Date		Max Order Qty						Black & White
or Color				Item Category
Form (F) or Book (B)		Binding/Stitching		Orientation		Sides Printed				Printing Paper Size Width		Printing Paper Size Length		Number of Forms to a Sheet		Page Count of Publication		Number of Sheets Required to Print		CSS/JLS Production Stock		Paper Stock Type		Paper Stock Weight		Paper Stock Color		Stack Offset		Tab Size		Number of Tabs Needed		Binder Size		Binder Color		Binder Ring Type		Binder Transparency		Thermal Tape Color		Finished Trim Size Width		Finished Trim Size Length		Stitching Location		Drill Hole Size		Number and Location of Drill Holes		Glue Location		Number of Pages per Pad		Fold Type		Fold At		Number of Pieces per Poly wrap		Number of Pieces per Box		Comments		Part Number

		Are these items being setup on dPrint? (Yes or No). If yes, Inv Mgmt to check "Print Management" flag on item setup.		The content/Comp # will be provided by the CSC once the spec files are loaded to the DAS (the files must be named with the WCSS item #). The content/comp# must be hardcoded to the Item message Field in WCSS. Must be a 10 Digit number that starts with an 8.		Required. Setting this to yes will allow warehouse product to ship out before the JIT item is completed. Setting this to no will hold all warehoused items until the printing of this item is complete. Please indicate Y or N.** Note: Each item with a Y will always ship separately even if produced at the same time as like items.		Optional. 15 Characters Max. If the WCSS number provided already exists in the system, then Inventory Management will assign a random WCSS number.		30 characters maximum.		Cannot use quote symbol, that is--"--.		Required.  Which plant/Print Center will produce this item?		Required. To be provided from the producing plant for JIT s/u		Required: What is the plant code of the plant that has owning rights to the dPrint files? If produced at multiple plants there can be only one owning plant.		Required. What is the plant code of the facility that will produce this item? (see "Plant and Whse Codes" tab below)		Required. Enter one of the applicable product.		Method of packaging for publication shipment

Click here for explanation of each value in the pull-down				Required.  This field auto-calculates (transfer cost divided by .5). Used to determine Standard Cost on WCSS (which is 50% of the list price for these product codes).		Required. Transfer Cost per ordering/packaging unit of measure.		Required. Price that will be billed to customer upon order.  If Price Breaks, enter "Price Breaks" and note them on separate spreadsheet.		Required. Replacement Cost per Packaging/ordering UOM.				Click here for an explanation of this field; otherwise, type NA.		Optional.  Used to assist customer with internal Chargebacks to end users. (per packaging/ordering UOM)		IMPORTANT: This information must match the DocMan record.

Click here for explanation of each value in the pull-down menu.		IMPORTANT: This information must match the DocMan record.		IMPORTANT: This information must match the DocMan record.

Date on the publication.		Click here for explanation of each value in the pull-down menu.		Indicate Yes or No.  
Enter Yes if the item is a sequentially numbered item.		Describe the details behind the sequentially numbered item, such as:
- Record Sequence Shipped: whse will record the sequence numbers that shipped
- Ship in Sequence Record: required to ship products in particular sequence and the whse records the numbers				Required:                If PDF is to be retained in the DAS enter DAS in this field, if item is part of eCreate or Custom Docs put CUSTOM in this field.		Typically a Book.

Click here for explanation of each value in the pull-down menu.		Click here for explanation of each value in the pull-down				Click here for explanation of each value in the pull-down menu.		Optional: Use when finished product stored in the warehouse is to be inserted into the construction of a JIT book.		IMPORTANT: Not Trim Size width

This is the width of the paper on which the publication is printed.		IMPORTANT: Not Trim Size length

This is the length of the paper on which the publication is printed.		Click here for explanation of how to determine the information required.				Click here for explanation of how to determine the information required.		Optional:              Use when product is being printed on Shell Stock. Provide warehoused WCSS Item nu,mber of product to be used in the production of JIT item.		Click here for explanation of how to determine the information required.				The pull-down menu lists the most common choices.

Click here for a full list of the available choices.

If you use a choice not in the pull-down list, type the value in the cell below the pull-down menu.				If item uses tabs; otherwise, NA.		If needed; otherwise type NA.		If item used in a binder; otherwise, NA.		If item used in a binder; otherwise, NA.		If item used in a binder; otherwise, NA.		If item used in a binder; otherwise, NA.		If publication is thermal tape bound; otherwise, NA.		Click here to see the available finished trim sizes.

The sizes are listed - width x length.		Click here to see the available finished trim sizes.

The sizes are listed - width x length.		If publication is Book [B] and stapled; otherwise, NA.				Click here for a list of possible drill locations		If publication uses padding; otherwise, NA.		If publication is a notepad or message pad; otherwise, NA.		Click here for explanation of each value in the pull-down menu. 
Folding of final document optional		The location(s) of the fold		Click here for explanation of each value in the pull-down menu.				Use this column to list:
- Cover Stock
- Text Stock
- Cover Ink
- Text Ink
- Spine, if necessary

Also use to indicate any other production or finishing requirements not provided in previous columns

Click here for an explanation of the available Cover Stock, Cover Ink and Text Ink values.		List only if pubication is used in manufacturing; otherwise, leave blank.

																								PK												1								See DocMan for the Cost Center selections associated with each Business Group.										Color				B		SADDLE		PORTRAIT		HEAD2HEAD				RRD must provide this information		RRD must provide this information														White		RRD must provide this information		NA		NA		NA		NA		NA				NA		8.5		11		SIDE		NA		NA		NA		NA		HALF		8.5 x 11		50		RRD must provide this information



Click here for explanation of each value in the pull-down

Method of packaging for publication shipment

Click here for explanation of each value in the pull-down

IMPORTANT: This information must match the DocMan record.

Click here for explanation of each value in the pull-down menu.

Click here for explanation of each value in the pull-down menu.

Typically a Book.

Click here for explanation of each value in the pull-down menu.

Click here for explanation of each value in the pull-down menu.

Click here for explanation of how to determine the information required.

Click here for explanation of how to determine the information required.

Click here for explanation of how to determine the information required.

The pull-down menu lists the most common choices.

Click here for a full list of the available choices.

If you use a choice not in the pull-down list, type the value in the cell below the pull-down menu.

Click here to see the available finished trim sizes.

The sizes are listed - width x length.

Click here to see the available finished trim sizes.

The sizes are listed - width x length.

Click here for a list of possible drill locations

Click here for explanation of each value in the pull-down menu.

Use this column to list:
- Cover Stock
- Text Stock
- Cover Ink
- Text Ink
- Spine, if necessary

Also use to indicate any other production or finishing requirements not provided in previous columns

Click here for an explanation of the available Cover Stock, Cover Ink and Text Ink values.

Click here for an explanation of this field; otherwise, type NA.

Click here for explanation of each value in the pull-down menu. 
Folding of final document optional



Field definitions

		

		Packaging/Ordering Unit Of Measure

				EA = Each

				PK = Pack

				PD = Pad

				RL = Roll

				BK = Book

				CT = Carton

				BX = Box

				ST = Set

		Multiple Order Qty

				Separate methods of ordering same item. For example, if an item is packaged 50 per pad / 5 pads per carton. You can set the order qty as 50 each (one pad) or 250 each (1 ctn)

		Business Group

				The business group that the publication supports. Your choice here determines the list you choose from for Cost Center.

				Corporate/Business Development

				Finance

				Human Resources

				IT

				Logistics

				Manufacturing

				Marketing Commercial

				Marketing Europe

				Marketing Other

				Operations

				Order Services

				Other

				Process Improvement

				Procurement

				Quality

				Sales

		Max Order Quantity

				Presale items = 100

				Postsale items = 5

				NOTE: You can use other quantities but the delivery may take a bit longer because a system admin must approve it.

		Item Category - Form (F) or Book (B)

				Form (F) = Any publication that is a single sheet (i.e., 1 or 2 pages), an envelope or carbonless form.

				Book (B) = Any publication that contains 3 or more pages.

		Binding/Stitching

				For a Form (F) use

				CARBONLESS

				CUTSHEET

				ENVELOPE

				For a Book (B) use

				LOOSE		LOOSE -Loose Leaf

				PERFECT		PERFECT - Perfect Bound

				PLASTCOIL		PLASTCOIL - Plastic Coil (Coil Bound)

				SADDLE		SADDLE - Saddle Stitch

				STAPLED1		STAPLED1 -1 position

				STAPLED1B		STAPLED1B - bottom 1 position

				STAPLED2		STAPLED2 - 2 positions

				THERMAL		THERMAL - Thermal bound (Tape bound)

				THERMALO		THERMALO - Thermal Bound (Tape bound - offline)

				WIRE O		Wire O - Double Wire Bound (offline)

				Saddle-Stitch Items

				20 sheets max. on 20# (text and cover)

				19 sheets max. on 20# (text) and 24# (cover)

				18 sheets max. on 24# (text and cover)

				All page quantities must be divisible by 4

				Tape Bound Items

				125 sheets max. on 20# no cover

				120 sheets max. w/cover (90# index unless indicated otherwise)

				Perfect Bound Items

				475 sheets max. on 20# no cover

				470 sheets max. w/cover (90# index unless indicated otherwise)

				Double Wire Bound Items

				40 sheets max. on 20# (if adding cover deduct equivalent number of pages to equal cover thickness) (90# index unless indicated otherwise)

				Coil Bound Items

				290 sheets max. of 20# (if adding cover deduct equivalent number of pages to equal cover thickness) (90# index unless indicated otherwise)

		Sides Printed

				Head2Head = Most common; Double-sided printing with headers on both pages lining up at the top of the page

				Simplex = Single-sided printing

				Head2Toe = Least common; Double-sided printing with header on one page lining up with the footer on the other page

		Number of Forms to a Sheet

				Number of publication pages printed on a sheet of paper at the printer.

For example, if a 4-page, 8.5 x 11 publication is printed on the front and back sides of an 11 x 17 sheet of paper that is folded in half, the Number of Forms to a Sheet = 4.

Example 2: If a 4-page, 5.5 x 8.5 publication is printed on the front and back sides of an 8.5 x 11 sheet of paper that is folded in half, the Number of forms to a Sheet = 4.

		Number of Sheets Required to Print

				Number of sheets of paper required to print the publication.

For example, if a 16-page, 8.5 x 11 publication is printed on the front and back sides of four 11 x 17 sheets of paper that are folded in half and saddle stitched together, the Number of Sheets Required to Print = 4.

Example 4: If a 4-page, 5.5 x 8.5 publication is printed on the front and back sides of one 8.5 x 11 sheet of paper that is folded in half, the Number of Sheets Required to Print = 1.

		Paper Stock Type

						Description

				PLAIN		Bond

				ACNTCVR		Accent Cover

				BOND3H		Bond (3-hole)

				BOOKENV		Booklet Envelope

				C1SGLOSS		C1S Gloss Finish

				C1SMATTE		C1S Matt Finish

				C2SGLOSS		C2S Gloss Finish

				C2SMATTE		C2S Matt Finish

				CARD		Card Stock

				CATLGENV		Catalog Envelope

				CATLGENV#6		#6 Catalog Envelope

				COVERCOLOR		Color Cover Copy

				CRCKPEEL		Crack N Peel Label

				CUSTOM		Custom

				CVRFUTURA		Futura Cover

				ENV6x9		Standard 6X9 Envelope

				ENV9X12		Standard 9X12 Envelope

				ETHCERT		Ethicon Certificate

				GLOSSCOVER		Gloss Cover

				GLOSSTEXT		Gloss Text

				HOTSTEXT		Hots Text

				INDEX		Index

				LABEL80		80 Up Label

				MICROPRT		Micro Print

				OFFSET		Offset

				PART2		2 Part

				PART3		3 Part

				PART4		4 Part

				PART5		5 Part

				PART6		6 Part

				PERF		1/2 inch Perfed

				PERMMAT		Perm Mat Ad

				PRECUTTAB		Pre-Cut Tab

				PREPERF		Pre-Perforated

				RECYL		Recycled

				SE10ENV		#10 Standard Envelope

				SE10ITENV		#10 Inside Tint Envelope

				SE9ENV		#9 Stanard Envelope

				TAG		Tag

				TEXT		Text

				TEXTCOLOR		Text Color Copy

				TEXTFUTURA		Futura Text

				TEXTLASER		Text Laser Print

				TRANSPRNCY		Transparencies

				VELLUM		Vellum

				VELLUM3HP		Vellum 3HP

				WE10ENV		#10 Window Envelope

				WE9ENV		#9 Windor Envelope

				WE9ITENV		#9 Inside Tint Window Envelope

		Paper Stock Color

				Black

				Blue

				Buff

				Canary

				Cherry

				Clear

				Cream

				Custom

				Goldrenrod

				Gray

				Green

				Ivory

				Lavender

				Manilla

				NCRPinkCanary

				NCRWhiteBlue

				NCRWhiteBlueCanary

				NCRWhiteCanary

				NCRWhiteCanaryPink

				NCRWhiteCanaryPinkGoldenrod

				NCRWhiteGreen

				NCRWhiteGoldenrodYellow

				NCRWhitePink

				NCRWhiteWhite

				Opaque

				Orange

				Orchid

				Peach

				Pink

				Purple

				Salmon

				Tan

				Violet

				White

		Finished Trim Sizes (listed - width x length)

				11 x 17

				18 x 24 Poster

				24 x 36 Poster

				3 x 5

				36 x 24 Poster

				4 x 6

				4.75 x 7

				4.75 x 7.75

				5.5 x 8.5

				6 x 4

				7 x 9

				7.385 x 9 (RSI Std)

				8.5 x 11

				8.25 x 10.875

				8.25 x 11 (RA product profile std)

				8.375 x 10.875

				9 x 12

				A4

				A5

				Other - Custom size listed below

		Drilling Locations

				1CENTER

				1LEFTTOP

				1TOPCENTER

				2LEFT

				2LEFT2TOP

				2TOP

				2TOP2LEFT

				2TOP3LEFT

				2TOP5LEFT

				2TOP5RIGHT

				3BOTTOM

				3LEFT

				3LEFT2TOP

				3LEFT3TOP

				3RIGHT

				3TOP

				3TOP5LEFT

				5BOTTOM

				5CENTER

				5LEFT

				5RIGHT

				5RIGHT2TOP

				5TOP

				For TRI fold - select Z or C type		Description

				HALF		Half

				C		C Fold

				DBLEPARLL		Double Parallel

				OFFSETZ		Offset Z

				SAMPLE		See Sample

				SHORT		Short Fold

				V		V Fold

				Z		Z Fold

		Number of Pieces per Poly Wrap

				Publication length		Number per Poly Wrap

				77 or more pages		1

				33 to 76 pages		25

				3 to 32 pages		50

				1 or 2 pages		100

		Comments

				Cover/Text Stock		Spine

				100# Gloss Cover		If your publication uses a spine, make note of that in the comments field. Be sure to include the spine as the last page of your PDF. Do NOT include that page as part of the publication page count. Because the addition of a spine will create an odd page count in the PDF, contact a Super User to submit your publication via PDFdirect with an exception tool.

				100# Gloss Text

				100# Text

				10pt C1S Cover

				10pt C2S Cover

				10pt C2S Text

				10pt Text Stock

				110# White Index

				12pt C1S Cover

				20# White Opaque Bond

				50# Colored Offset

				50# White Offset

				50# White Opaque

				60# Cover Stock

				60# White Offset

				80# Gloss Cover

				80# Gloss Text

				8pt C1S White

				90# White Index

				Cover/Text Ink

				Black

				Black + 1 PMS color		Type in PMS color

				Black + 2 PMS colors		Type in PMS colors

				4 color

				4 color over black

				4 color + 1 PMS color		Type in PMS color

				4 color over black + 1 PMS color		Type in PMS color

				4 color + 2 PMS colors		Type in PMS colors

				4 color + aqueous

				4 color + varnish
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